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Documentation Updates

The title page of this document contains the following identifying information:

• Software Version number, which indicates the software version.

• Document Release Date, which changes each time the document is updated.

• Software Release Date, which indicates the release date of this version of the software.

To check for recent updates, or to verify that you are using the most recent edition of a 
document, go to:

http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign-in. To register for an HP 
Passport ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product 
support service. Contact your HP sales representative for details.
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Support

Visit the HP Software Support web site at:

http://www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and 
support that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and 
efficient way to access interactive technical support tools needed to manage your business. 
As a valued support customer, you can benefit by using the support web site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. 
Many also require a support contract.  To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html 

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp 
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Service Test Management User Guide

Welcome to HP Service Test Management, a complete solution for managing 
the process of testing application components and their changes in service-
oriented architecture (SOA) and other GUI-less systems. Service Test 
Management integrates with HP Quality Center to provide a Web-based 
solution for testing the quality and performance of all types of application 
components throughout the entire application development life cycle. 

Note: This guide explains how to manage tests in conjunction with Quality 
Center. For additional information on using Quality Center, refer to the 
HP Quality Center User’s Guide.

How This Guide Is Organized
This guide contains the following chapters:

Chapter 1 Introduction to Service Test Management

Provides an introduction to the Service Test Management model and its 
integration with Quality Center.

Chapter 2 Creating Application Components

Describes how to create a Components tree and define components and 
component groups.
9



Welcome to This Guide
Chapter 3 Web Services

Describes how to work with Web Service type application components and 
the unique features available for Web Services.

Chapter 4 Managing Components in Quality Center

Describes how to view and modify component details, definitions, and 
operation data, generate Excel reports, remove and restore components, and 
define component dependencies.

Chapter 5 Groups

Describes how to create component groups and associate application 
components to them.

Chapter 6 Generating Requirements and Tests

Describes how to use the Requirement and Test Generation wizard to 
automatically generate requirements and tests and how to create empty 
tests.

Chapter 7 Determining Test Coverage

Shows the testing status with graphical displays of test, requirement, and 
defect coverage.

Chapter 8 Linking Components and Requirements

Describes how to link components to requirements and tests.

Chapter 9 Customizing Service Test Management

Describes how to customize the Application Components module, user 
group permissions, module access, and project entities for components and 
groups.

Chapter 10 Change Analysis

Describes how to identify changes in components and analyze their impact 
on related assets in Quality Center. Also describes how to create and run test 
sets to test the impact of these changes.
10



Welcome to This Guide
Chapter 11 Reports and Graphs

Describes how to generate graphs and Excel reports to represent your 
components and their coverage.

Chapter 12 Custom Script Generators

Extends the capabilities of the Service Test Management Requirement and 
Test Generation Wizard through an external script generator.

Documentation Library
The Documentation Library is an online help system that describes how to 
use the application. When using Service Test Management in the Quality 
Center application, you can access the Quality Center Documentation 
Library or the Service Test Management Documentation Library.

➤ Quality Center Documentation Library. When working in any module other 
than the Application Components module, you can access the Quality 
Center Documentation Library in the following ways:

➤ Click Documentation Library in the Help menu to open the Quality 
Center Documentation Library home page. The home page provides 
links to the Quality Center guides and references.

➤ Click Help on this page in the Help menu to open the Documentation 
Library to the topic that describes the current page.

➤ Service Test Management Documentation Library. When working in the 
Application Components module, you can access the Service Test 
Management Documentation Library. Select Help > Help on this page to 
open the Help window. Click the Search and Navigate button in the top left 
corner and then go to the Home link. The Service Test Management 
Documentation Library home page provides links to the Testing guides.

The Documentation Library is best viewed from a browser with Java 
support. If you do not have Java support on your browser, download the Sun 
Java plug in from the Sun Java Web site (http://java.com/en/index.jsp). Note 
that if Java support is not available, the Documentation Library 
automatically opens using the JavaScript implementation. The JavaScript 
implementation provides the same basic functionality as the Java 
implementation, however does not allow use of the Favorites tab within the 
navigation pane.
11
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Welcome to This Guide
Service Test Management Documentation Library Guides

The Service Test Management Documentation Library consists of the 
following guides, available online, in PDF format, or both. PDFs can be read 
and printed using Adobe Reader which can be downloaded from the Adobe 
Web site (http://www.adobe.com).

Readme provides last-minute news and information about Service Test 
Management.

HP Service Test Management User’s Guide explains how to use Service Test 
Management to facilitate the complete application delivery life cycle for 
application components. (Available online and in PDF format.)

HP Service Test Management Installation Guide explains how to install 
Service Test Management on a server machine as an extension to Quality 
Center. (Available in PDF format only.)

HP Service Test User’s Guide explains how to use Service Test to create 
scripts for SOA environments. (Available in PDF format only.)

Quality Center Documentation Library Guides

The Quality Center Documentation Library consists of the following guides 
and references, available online, in PDF format, or both. PDFs can be read 
and printed using Adobe Reader which can be downloaded from the Adobe 
Web site (http://www.adobe.com).

Getting Started explains how to use the Documentation Library and how it 
is organized. (Available online.)

What’s New? describes the newest features in the latest versions of Quality 
Center. (Available online and in PDF format.)

You can also access the What’s New? from the Quality Center Help menu. In 
addition, you can choose Help > Product Feature Movies to view short 
movies which demonstrate the main product features. 

Readme provides last-minute news and information about Quality Center. 
12
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Welcome to This Guide
Quality Center Guides

HP Quality Center User’s Guide explains how to use Quality Center to 
organize and execute all phases of the testing process. It describes how to 
define requirements, plan tests, run tests, and track defects. (Available 
online and in PDF format.)

HP Quality Center Administrator’s Guide explains how to create and 
maintain projects using Site Administration, and how to customize projects 
using Project Customization. (Available online and in PDF format.)

HP Quality Center Tutorial is a self-paced guide teaching you how to use 
Quality Center to manage the software testing process. (Available in PDF 
format.)

HP Quality Center Installation Guide explains how to install Quality Center 
on a server machine in a cluster environment or as a stand-alone 
application. (Available in PDF format.)

Business Process Testing Guides

HP Business Process Testing User’s Guide explains how to use Business 
Process Testing to create business process tests. (Available online and in PDF 
format.)

HP Business Process Testing Tutorial provides a self-paced guide that teaches 
you the basics of Business Process Testing in the Quality Center application. 
(Available in PDF format.)

API References

HP Quality Center Database Reference provides a complete online reference 
for the project database tables and fields. (Available online.)

HP Quality Center Open Test Architecture API Reference provides a 
complete online reference for the Quality Center COM-based API. You can 
use the Quality Center open test architecture to integrate your own 
configuration management, defect tracking, and home-grown testing tools 
with a Quality Center project. (Available online.)
13



Welcome to This Guide
HP Quality Center Site Administration API Reference provides a complete 
online reference for the Site Administration COM-based API. You can use 
the Site Administration API to enable your application to organize, manage, 
and maintain Quality Center users, projects, domains, connections, and site 
configuration parameters. (Available online.)

HP Quality Center Custom Test Type Guide provides a complete online 
guide on how to create your own testing tool and integrate it into the 
Quality Center environment. (Available online.)
14



1
Introduction to Service Test Management

This chapter includes:

Concepts

➤ Service Test Management Overview on page 15

Concepts

Service Test Management Overview 

When developing an application comprised of many components, it is 
essential that you organize the components and keep track of their tested 
status. Service Test Management, in conjunction with other HP testing tools, 
enables you to test and organize the application components. You can 
ensure that they perform their intended function and that they are able to 
scale to the needs of the applications that use them.

Service Test Management’s Application Components module in Quality 
Center, enables you to centrally manage your assets. Using this module, you 
can define and store application components in Quality Center’s repository. 
After you define components, you can generate a set of requirements and 
tests to validate the functionality, interoperability, security, boundaries, 
standards compliance, and performance of the components in your 
application. You can then run tests and view results in the Test Plan and Test 
Lab modules.

Service Test Management also provides change analysis that highlights 
changes in the components and evaluates the impact that they may have. 
Based on these changes, Service Test Management can automatically 
generate the test sets that are required to validate the component.
15



Chapter 1 • Introduction to Service Test Management
This section also includes: 

➤ "The Service Test Management Integrated Solution" on page 16

➤ "The Advantages of Service Test Management" on page 16

The Service Test Management Integrated Solution 
Service Test Management is an integrated solution that allows you to 
manage the quality of your application components, such as .NET, Java, or 
Web Service applications. It integrates the following HP products:

➤ HP Quality Center. Enables you to centrally manage SOA assets from the 
Application Components module. You can define, import, and store services 
in Quality Center, and generate the necessary requirements and tests.

➤ HP Service Test. Enables you to automatically create scripts for testing your 
SOA environment. You can edit tests generated using Service Test 
Management, run tests, view results, reuse components and services, and 
create an emulation of a Web service for testing purposes.

➤ HP LoadRunner/HP Performance Center. Enable you to perform load testing 
on services, and monitor and predict their performance under load. 
HP LoadRunner Analysis allows you to drill down to determine the specific 
source of bottlenecks and generate actionable reports.

➤ HP Systinet Registry. Enables you to import Web services from the HP 
Systinet Registry (supports Systinet 2 with Service Pack 1 or later).

The Advantages of Service Test Management
Service Test Management provides the following features:

➤ A complete testing process that includes functional testing and 
performance testing.

➤ Automatically generated requirements and tests that validate the 
functionality (positive and negative), interoperability, standards 
compliance, security, and performance of an application component or 
service.

➤ Reusable tests that can be combined and extended across teams, 
providing easier transfer of knowledge and test data.
16



Chapter 1 • Introduction to Service Test Management
➤ Change management and change impact testing that highlights changes 
in application components and environments, and evaluates the impact 
that changes may have on different applications.
17



Chapter 1 • Introduction to Service Test Management
18



2
Creating Application Components

This chapter includes:

Concepts

➤ Creating Application Components Overview on page 19

Tasks

➤ How to Define Components on page 24

Reference

➤ Quality Center Direct Links on page 26

➤ Application Components Module User Interface on page 27

Concepts

Creating Application Components Overview

You add entities to the Application Components tree by manually adding a 
new components. After you add a component, you can describe it through a 
contract. 

Once you define application components, you can link them to 
requirements. This linkage allows you to connect the component to other 
Quality Center entities, such as tests, test sets, and defects.
19



Chapter 2 • Creating Application Components
This section also includes: 

➤ "The Application Component Tree Hierarchy" on page 23

Application Component Design

Stage 1 - Prepare to collaborate

The QA (Quality Assurance) and Dev (Software Development) managers 
prepare to collaborate in describing the components or the AUT 
(Application Under Test). 

QA will use that information to track changes, execute tests, and report on 
the quality of the product.

Stage 2 - Set a methodology

Set a methodology to describe the application:

➤ What are the application areas in the AUT, to be translated into folders in 
the component hierarchy?

➤ What will constitute a component. For example, only high-level 
interfaces may be considered components, or its centrality or importance 
in the application? 

➤ What component types to define? This could be based on technology, 
usage, and so forth. 

➤ What fields (and possibly UDF) to associate with the component types?

Stage 3 - Quality policies

Determine quality policies to be implemented through rules and testing 
aspects. These policies are necessary to insure that components are tested 
based with the correct data.

Stage 4 - Create a project and customize it

Create an Service Test Management project or enable the extension on an 
existing Quality Center project. Open Customization and define component 
types and their fields, as well as UDFs for component and changes. Define 
the necessary rules and testing aspects.
20



Chapter 2 • Creating Application Components
Stage 5 - Create the application components

Open the Application Components module and create a folder structure to 
represent the application areas decided on above. Create component groups 
for cross-area functionality or deployment. If possible, define high-level 
components based on the planned strategy. If not possible, the developers 
can define them at a later time.

The project is ready for the QA and the software development teams may 
begin using it.

Stage 6 - Report changes to QA

Developers use the IDE add-on to report changes back to QA. Developers 
implement requirements and fix defects. They can create new components 
or application areas as required. These actions will be reported to Service 
Test Management and assigned to an existing or new application 
component. They can also be linked to the work item such as a requirement 
or defect, if one exists. 

When making changes, developers describe their risk to QA, to assist them 
in their testing.

Developers may report a change while still in the process of enacting the 
change. This allows QA to prepare for testing the change. Optionally, the 
developers can wait until the change has been completed before reporting it 
to QA.

Stage 7 - QA processes changes

Before changes are gathered, QA can begin reviewing the application 
components and assign requirements and tests.

QA engineers can create new component groups to facilitate the 
management of the components.

After changes are generated, Service Test Management marks the changed 
components with alert icons and lists them in the Changes tab. QA uses the 
information in the Interaction tab to create tests for the changed 
components, using the change description to verify the coverage. During 
this process, QA can set the following fields:
21



Chapter 2 • Creating Application Components
➤ Change status to In test. 

➤ Assigned to developer to determine the developer regarding an aspect of 
the component’s functionality.

➤ Created by in the Change tab, to determine the developer who is 
responsible for updating the component’s functionality.

QA can see the changes for one or more components:

➤ Select a component to view the changes specific to that component, and 
review its Changes tab, 

➤ Select a group or folder to view an aggregated list of changes in the 
Changes tab. The Changes grid provides the context of the change which 
can assist QA in understanding the issue.

Stage 8 - Run tests

QA executes tests on the AUT in the testing environment. Based on the test 
results, they can set the status to verified or keep the In test status. if a 
change was tested it is considered verified, even if causes defects in the 
component.

Stage 9 - Reporting

QA uses the graphs and reporting capabilities to summarize the status of the 
components of the AUT and the changes. They send this report back to the 
development team. The developers can decide how to act upon QA’s 
recommendations.

The on-going reporting should show a trend of more changes being verified 
in less time, and a downward trend in the number of defects on the 
components.

In conclusion, the Application Components module allows QA and the 
developers to verify the quality of the AUT in a comprehensive fashion. 
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Chapter 2 • Creating Application Components
The Application Component Tree Hierarchy
Service Test Management provides you with tools to define components and 
modify their details. 

You organize your application components in a graphical hierarchy. 

At the top level of the tree is the Application Components root folder, which 
contains sub folders. You can create custom folders that represent the 
structure of components in your application. For example, you might create 
separate folders to represent different types of users.

You can reorganize related entities in folders and subfolders, and drag and 
drop folders or subfolders to other locations in the tree. 

The Obsolete folder contains components that were removed, but are still 
being used by tests stored in Quality Center. For details about the Obsolete 
folder, see "Remove and restore components - optional" on page 82. 

You cannot rename, move, or delete the Application Components folder or 
the Obsolete folder.

Component Dependencies

Component dependency defines a relationship between two or more 
components. As the operations of these linked components change, you can 
detect changes and track their impact on the linked components.

You can define the dependencies using Service Test Management’s Modeling 
tab. The Modeling tab displays a diagram of the component dependencies. 

An arrow indicates a dependency: 

➤ An arrowhead pointing to the base component, indicates a Dependency 
From another component—the added component impacts the base 
component. 

➤ An arrowhead pointing away from the base component indicates a 
Dependency To another component—-the added component is impacted 
by the base component.
23



Chapter 2 • Creating Application Components
You select components and add them to a modeling diagram. In the 
following example, the LoginService component is dependent on AddrBook 
and DataType. The Echo and Calc components are dependent on 
LoginService.

Although you drag in the dependent components, the dependencies are 
actually per operation. For details, see "Define dependencies - optional" on 
page 25.

Tasks

How to Define Components

This task describes how to set up your components in Service Test 
Managements. After you set them up, you can test them and check their 
functionality and compliance.

➤ "Create a folder - optional" on page 25

➤ "Create a new component" on page 25

➤ "Specify a contract" on page 25
24



Chapter 2 • Creating Application Components
Create a folder - optional

Open the New Folder dialog box and add new folders and subfolders to 
create a tree hierarchy for your components. For details, see the "New Folder 
Dialog Box" on page 43.

You can create folders at any time and drag or copy components from folder 
to folder. 

Create a new component

Select Components > New > New Component to create an new component 
and provide whatever details are available to you. For details, see the "New 
Application Component Dialog Box" on page 43.

Specify a contract

In the New Application Component Dialog Box, click the Interaction link in 
the left pane. Click Browse to locate a contract file. For details, see the "New 
Application Component Dialog Box" on page 43.

Define dependencies - optional

 1 Select the Modeling tab. For a description, see the "Modeling Tab" on 
page 36.

 2 Click the Select Entities button to open the Components list in the right 
pane. Expand the folders and select a component.

 3 Click the arrow to open the transfer menu.

 a To add a component that is dependent on the base component, click Add 
Component Dependency (Dependency To).

 b To add a component upon which the base component is dependent, click 
Add Component Dependency (Dependency From).

The Dependency Details dialog box opens. Select the operation that affects 
the dependency. If you do not know which operation to select, specify all of 
them. For details, see the "Dependency Details Dialog Box" on page 42
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Chapter 2 • Creating Application Components
Reference

Quality Center Direct Links 

You can use direct links to access specific views and components. You enter 
the direct link into your browser to access the desired view. You can save 
these links for future reference, or send them to others by e-mail so that 
they may access a specific view or component. 

When working with Systinet, you can use a direct link to access the import 
screen, enabling you to locate services quickly.

The direct links use the following format:

td://<project_name>.<domain>.<server:port>/qcbin/

The following table describes the shortcut syntax to be added to the above 
string. Italic text indicates optional parameters.

View Description

Systinet Import 100?Action=ImportSystinet&SystinetID=
[SYSTINET_KEY]&Environment=<ENVIRONMENT>&Uui
d=<UUID>
26



Chapter 2 • Creating Application Components
Application Components Module User Interface

Service Test Management provides a user interface to organize your 
application components and customize the Quality Center project hosting 
them.

This section includes (in alphabetical order):

 ➤ Alerts Dialog Box on page 28

 ➤ Details Tab on page 29

 ➤ Interaction Tab on page 32

 ➤ Find Dialog Box on page 35

 ➤ Modeling Tab on page 36

Component StmModule--0000000000003130674279? 
EntityType=IStmService&EntityID=<component 
id>&View=<service tab type>

<component tab type> values: 

➤ Changes

➤ Modeling

➤ TestingStatus

➤ AspectStatus

➤ OperationStatus

➤ StatusDashboard

Component Group StmModule--0000000000003130674279? 
EntityType=IStmGroup&EntityID=<group 
id>&View=<group tab type>

<group tab type> values: 

➤ Modeling

➤ TestingStatus

➤ AspectStatus

➤ StatusDashboard

View Description
27



Chapter 2 • Creating Application Components
 ➤ Dependency Details Dialog Box on page 42

 ➤ New Folder Dialog Box on page 43

 ➤ New Application Component Dialog Box on page 43

 ➤ Application Components Module Icons on page 47

 ➤ Application Components Module Window on page 48

 ➤ Application Components Module Menus and Buttons on page 50

Alerts Dialog Box

Displays all alerts and rule violations associated with the selected 
component and enables you to resolve or disregard them.

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

To access Click the red exclamation point ,adjacent to the 
component name in the Application Components tree.

Relevant tasks "Evaluate the tests" on page 160

See also "Change Analysis" on page 155

UI Elements (A-Z) Description

Removes the current rule violation in the Rule Violations 
pane:

Note: When removing a rule violation, Service Test 
Management disregards it—it does not delete it.

Removes all rule violations in the Rule Violations pane:

Note: When removing a rule violations, Service Test 
Management disregards it—it does not delete it.
28



Chapter 2 • Creating Application Components
Details Tab

Displays and enables you to edit a component’s details.

For change alerts, this button opens the Changes tab 
listing all of the changes. Use the Create Test Set utility 
to resolve the changes. 

For details, see the "Create Change Impact Test Set 
Wizard" on page 167

For rule violations, this button opens the Create 
Requirements Test wizard in order to resolve the 
violation. For details, see the "Generate Requirements 
and Tests Wizard" on page 97.

Alerts for 
<component name>

A link to the component in the Application 
Components tree.

Changes An expandable/collapsible list of all change alerts specific 
to the selected component. Indicates a change to the 
component file since its last import or update.

Rule Violations An expandable/collapsible list of all rule violations for 
the selected component. A common rule violation is 
missing coverage for a testing aspect.

To access Select Application Components module, highlight a 
folder, component, or group, and click the Details tab.

Important 
information

The Details tab fields differ, depending on the entity you 
select: folder, component, or group, and the component 
type.

Relevant tasks "Manage component details - optional" on page 80

See also "Application Component Details Pane" on page 39

UI Elements (A-Z) Description
29



Chapter 2 • Creating Application Components
Details Tab for Components

The following elements are displayed when you select a component in the 
Component tree. 

GUI Element (A-Z) Description

<user-defined> User-defined fields defined in customization.

Assigned to Dev The name of the developer to whom the component 
implementation is assigned.

Assigned to QA The name of the QA engineer responsible for validating 
the component.

Component ID A read-only ID assigned to the component.

Component Name The native component name as provided by the user.

Component Type The type of component. The built-in components are 
General, Web Service, and JMS. If you defined a new 
component type, it will be displayed.

Created By The name with which you logged in. You can edit this 
field and specify a different name. This is useful for 
sorting the components in reports.

Creation Date The date the component was created in the Component 
tree.

Development Status The development status of the component: 
Development, Maintenance, QA ready, or Stable.

Keep up to date Keep the component up to date: Y or N. When enabled, 
instructs Service Test Management to update the 
component from its source each time you select it in the 
Application Component’s tree.

Last updated The last time the component was updated.

Visibility The component’s visibility level—Internal or External.
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Details Tab for Groups

The following elements are displayed when you select a group in the 
Components tree. 

Details Tab for Folders

The following elements are displayed when you select a folder in the 
Components tree: 

UI Elements (A-Z) Description

Assigned To The name of the user to whom the group 
implementation is assigned.

Created By The name with which you logged in. You can edit this 
field and specify a different name. This is useful for 
sorting the groups in reports.

Creation Date The date the group was created in the Components tree.

Description A description of the group.

 Name The name of the group.

UI Elements (A-Z) Description

Folder ID A read-only ID assigned to the folder.

Name The folder name in the Components tree.

Description A meaningful description of the folder.
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Interaction Tab

Displays and enables you to edit a component’s contract information.

To access Select Application Components module, highlight a 
component, and click the Interaction tab.

Important 
information

Only available when selecting a component in the tree. 
The information differs depending on the component 
type:

Relevant tasks "Manage component details - optional" on page 80

See also "Application Component Details Pane" on page 39.
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The Interaction tab contains the following information:

UI Elements (A-Z) Description

Contract Details ➤ Contract File. The location of the contract file defining 
the application component.

➤ . Opens the Open File or Import Service 
dialog box—visible for new components whose 
contracts have not yet been defined.

➤ . Opens the Open File dialog box. For 
Web Services, it opens the or Import Service dialog 
box—visible for components whose contracts have 
already been defined.

For more details, see the relevant section:

➤ "Import Service Dialog Box" on page 68.

➤ "Select Service from Systinet Dialog Box" on page 63

➤ "Select Service from UDDI Dialog Box" on page 64

Contract Details - 
Web Services

➤ Import type. Contract import method: File, URL, 
Systinet, and UDDI.

➤ Toolkit. The toolkit associated with the Web service. 
You set this in the Customization settings, and it is 
read-only.

➤ Service Address. The service deployment location, to 
which service requests are sent. By default, Quality 
Center displays the endpoint address specified in the 
WSDL file.

➤ Override Address. Enables you to enter an alternate 
endpoint for the service in the Service Address box.
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Contract Details - 
JMS

➤ JMS connection factory. The JNDI name of the JMS 
connection factory. This setting is unique per test.

➤ JMS destination. The name of the JMS destination—
either the queue or topic name.

➤ JMS provider. The JMS service provider: Apache 
ActiveMQ, JBoss Messaging from JBoss, Open Message 
Queue, Websphere MQ from IBM, and so forth.

➤ JNDI initial context factory. A The fully qualified class 
name of the factory class that will create an initial 
context. Provides a list of context factories and allows 
manual entries.

➤  JNDI provider URL. The URL of the service provider. 
For example: Websphere - iiop://myserver:myport

➤ Messaging Model. The type of JMS message—Point to 
point, or Publish and subscribe.

Interaction Fields The fields you designated in the Customization for the 
component type. For details, see "Component Types Tab" 
on page 147.

The common fields are:

➤ JMS Request Queue

➤ JMS Response Queue

➤ JMS Transport (Y or N)

➤ WSDL Native Name

Operations ➤ . Refresh. Reloads the list of operations.

➤ . Web Service Call. Opens the 
Run <operation-name> dialog box to send a test 
request to the server. For details, see the "Manual 
Runner Service Testing Tab" on page 71. Note: This 
option is only available if Service Test or the Service 
Test add-in is installed on the machine. 

➤ <Operation list>. A list of the available operations for 
the application component.

Parameters A list of the parameters for the selected operation. The 
list provides the parameter name, data type, and an 
indication of whether it is an input or output parameter.

UI Elements (A-Z) Description
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Interaction Tab for UDDI and Systinet Services 

For services imported through UDDI or Systinet servers, the Interaction tab 
shows several additional read-only fields:

Find Dialog Box

Enables you to search for a component, group, or folder within the 
Components tree. 

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

UI Elements (A-Z) Description

Systinet Server The URL address and port of the Systinet server from 
which the service definition is imported.

UDDI Server The URL address and version of the UDDI server from 
which the service definition is imported

UDDI/Systinet Key A unique identifier of the service on the UDDI or Systinet 
server, used to locate the service definition when 
updating the service

To access Edit > Find

Relevant tasks "Find folders and components - optional" on page 81

See also "Manage component details - optional" on page 80

UI Elements (A-Z) Description

Searches for the next occurrence of the text, based on the 
previously used settings.

Expands the Find dialog box to show the match criteria.

Collapses the Find dialog box to hide the match criteria.
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Modeling Tab

This tab displays component dependencies or component/group 
relationships in a visual representation. If you select a folder, it shows all 
associations and dependencies in groups and components beneath that 
folder.

This tab enables you to associate components with one another and assign 
them to component groups.

Entity Type Type of entity in which to perform the search: Folder, 
Component, or Group.

Find In Field The field within the Details tab upon which to perform 
the search. The available fields differ for a folder, group, 
or component.

For information about the fields in the Details tab, see 
"Details Tab" on page 29.

Match Criteria Advanced match criteria:

➤ Case Sensitive. Performs a case sensitive search.

➤ Exact Match. Looks for the exact string—not a partial 
string.

➤ Use Wildcard- Applies wildcard rules to the search text.

Value to Find The text to find in the component, group, or folder.

To access Choose the Application Components module, select a 
component or group, and click the Modeling tab.

Important 
information

If you select a component, the visual design shows the 
component dependencies.

Relevant tasks ➤ "Define dependencies - optional" on page 25

➤ "Add a component to a group" on page 86

See also "Component Dependencies" on page 23

UI Elements (A-Z) Description
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User interface elements are described below (unlabeled GUI elements are 
shown in angle brackets):

UI Elements (A-Z) Description

Opens the Components tree in the right pane to add 
more component or groups to the modeling window. For 
information about the tree hierarchy, see the 
"Components Tree" on page 38.

Delete. Removes the selected entity from the visual area. 
You cannot delete the base component or group that is 
selected in the left pane’s Component tree.

Refresh. Redraws the visual diagram in the visual area.

Arrange layout. Arranges the layout of all entities in the 
current modeling window, in a symmetric fashion.

Zoom in. Enlarges the entities in the current drawing.

Zoom out. Reduces the size of the entities in the current 
drawing.

<modeling window> A visual area showing component dependencies or 
component/group relationships in a graphical 
representation. 

Application 
Component/Group 
Details

Details of the component or group selected in the 
modeling window.

➤ For component details, see "Application Component 
Details Pane" on page 39

➤ For group details, see "Group Details" on page 41
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Components Tree

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

UI Elements (A-Z) Description

Add. Opens a dropdown list with the following options:

➤ Associate. Associates the selected component with a 
group.

➤ Add Dependency (Dependency To)

➤ Add Dependency (Dependency From)

Note: The Associate option is enabled when you select a 
group in the right pane. The Add Dependency options are 
enabled when you select a component in the right pane.

For details about dependencies, see the "Dependency 
Details Dialog Box" on page 42

Refresh. Refreshes the Components list.

Set/Clear Filter. Opens a dropdown list with the 
following options:

➤ Set Filter / Sort. Opens the Set Filter/Sort dialog box 
allowing you to filter and sort the components.

➤ Clear Filter / Sort. Clears all filters and sorting settings 
and displays all components and groups. 

Exit. Closes the Components tree pane

To reopen this view, click the Select button in 
the Modeling tab

<Components List> An expandable list of all components by folder and 
group. 

Tip: If a filter is active, there could be hidden 
components. To see all components, click Clear Filter.
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Application Component Details Pane
The following elements are displayed in the bottom pane of the Modeling 
tab, when you select a component in the modeling drawing. 

UI Elements (A-Z) Description

<user-defined> User-defined fields defined in customization.

Assigned to Dev The name of the developer to whom the component 
implementation is assigned.

Assigned to QA The name of the QA engineer responsible for validating 
the component.

Component Folder 
Path

The folder path of the component in the main 
Components tree.

Component ID A read-only ID assigned to the component.

Component Name The native component name in the definition files.

Component Type The type of component: General, Web Service, and JMS. 
If you defined a new component type in Customization, 
it will be displayed.

Contract file The path or URL of the component’s contract file.

Created By The name with which you logged in. You can edit this 
field and specify a different name. This is useful for 
sorting the components in reports.

Creation Date The date the entity was created in the Application 
Components tree.

Deleted On The date the component was deleted. This applies 
primarily to components in the Obsolete folder.

Development Status The development status of the component: 
Development, Maintenance, QA ready, or Stable.

Has Changed Y or N. Yes indicates that the definition files (for 
example, WSDL), changed since the last update.

Import type Contract import method: File, URL, Systinet, or UDDI.
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Keep up to date Y or N. When enabled, updates the contract from its 
source each time you select the component in the 
Application Component’s tree.

Last Updated The last time the WSDL was updated.

Location The location of the component’s source file (such as 
WSDL) that is displayed by default when defining the 
component. To override the default, select Override 
Address.

Original Location The original location of the WSDL This is relevant when 
you choose Override address and change the endpoint.

Override Address Enables you to enter an alternate endpoint for the service 
in the Service Address box (Web Services only).

Port Type The port type of the proxy server.

Service Address  The service deployment location, to which requests are 
sent. By default, Quality Center displays the endpoint 
address specified in the WSDL file. (For Web Service type 
components only)

Systinet ID The Systinet ID for the imported Web services.

Systinet Key The Systinet key for the imported Web services.

Systinet Server The URL address of the Systinet server from which the 
service definition is imported.

Systinet Server Port The port of the Systinet server machine.

Systinet Version The version of the Systinet server hosting the service.

Toolkit The toolkit associated with a Web service. You set this in 
the Customization settings, and it is read-only.

UDDI Server The URL address and version of the UDDI server from 
which the service definition is imported.

UDDI Service Key A unique identifier of the service on the UDDI server, 
used to locate the service definition when updating the 
service.

UDDI Version The version of the UDDI registry: 2 or 3.

UI Elements (A-Z) Description
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Group Details
The following elements are displayed in the bottom pane of the Modeling 
tab, when you select a group in the modeling drawing. 

Update Time The time the WSDL was updated.

Visibility The visibility of the application component: Internal or 
External.

WSDL native name The name of the Web Service as determined from the 
WSDL file. (For Web Service type components only)

UI Elements (A-Z) Description

Assigned To The name of the user to whom the group 
implementation is assigned.

Created By The name with which you logged in. You can edit this 
field and specify a different name. This is useful for 
sorting the groups in reports.

Creation Date The date the group was created in the Components tree.

 Name The name of the group.

UI Elements (A-Z) Description
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Dependency Details Dialog Box

Enables you to set the dependencies between components or modify 
existing ones.

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

To access In Modeling tab

➤ For a new dependency: Click Select to open the list 
of components in the right pane. Select a 
component and click the Add button to create a 
new dependency. The dialog box opens 
automatically.

➤ For an existing dependency: Click in the 
Component Dependency Details grid, select a 
dependency and click the Edit button .

Important 
information

An arrow indicates a dependency: 

➤ An arrow pointing to the base component indicates a 
Dependency From another component—the added 
component impacts the base component. 

➤ An arrow pointing away from the base component 
indicates a Dependency To another component—-the 
added component is impacted by the base 
component.

Relevant tasks "Define dependencies - optional" on page 25

UI Elements (A-Z) Description

<component_name> 
Operation

An operation with which to create a dependency, or All if 
you are unsure. 

Calls to 
<component_name> 
Operation

The operation through which to create the dependency. 
Use Any if you are unsure.
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New Folder Dialog Box

This dialog box page enables you to create a new folder in the Components 
tree.

User interface elements are described below:

New Application Component Dialog Box

Enables you to create a new component.

To access Use one of the following:

➤ Click the New Folder button.

➤ Select Components > New > New Folder. 

Important 
information

A folder name cannot include any of the following 
characters: \ / *

Relevant tasks "Create a folder - optional" on page 25

UI Elements (A-Z) Description

Folder Name A name for the new folder, beneath the folder selected in 
the Components tree. You can create several levels of 
sub-folders.

Tip: Add a description to the folder in the Details tab.

OK Adds the new folder to the Components tree.

To access Use one of the following:

➤ Select Components > New > New Component

➤ Select New > New Component from the shortcut 
menu

Relevant tasks "Create a new component" on page 25
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The following elements are included:

UI Elements (A-Z) Description

Clear All. Clears all the fields so that you can redefine the 
component.

Details pane. The component’s properties. The displayed 
fields differ based on the component type and the fields 
enabled in the customization section. For details, see the 
"Component Types Tab" on page 147. Some common 
fields are:

➤ Assigned to Dev

➤ Assigned to QA

➤ Created by 

➤ Development Status: Development, Maintenance, 
QA ready, or Stable.

➤ Last Updated

➤ Visibly: External or Internal

➤ Description tab. An editable area for a description of 
the component.

➤ Comments tab. An editable area for adding remarks.
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Interaction pane. Contract information.

The displayed fields differ based on the component type 
and the fields enabled in the customization section. To 
display a field in this section, select it in the 
customization’s Interaction Field column. For details, see 
the "Component Types Tab" on page 147. 

➤ Contract File. The location of the contract. 

➤

➤ For non-Web Service components, opens the Open 
File dialog box.

➤ For Web Services, opens the Import Service dialog 
box. For details, see "Import Service Dialog Box" on 
page 68. 

➤ Operations. A list of the component’s operations.

➤ Parameters. The component’s parameters sorted by 
the following columns: In/Out, Parameter Name, and 
Type (data type). 

 for JMS 
types 

➤ JMS connection factory. The JNDI name of the JMS 
connection factory. This setting is unique per test.

➤ JMS Destination. The name of the JMS destination—
either the queue or topic name.

➤ JMS Provider. The JMS service provider: Apache 
ActiveMQ, JBoss Messaging from JBoss, Open Message 
Queue, Websphere MQ from IBM, and so forth.

➤ JJNDI initial context factory. The fully qualified class 
name of the factory class that will create an initial 
context. Provides a list of context factories and allows 
manual entries.

➤ JNDI provider URL. The URL of the service provider. 
For example:

Websphere - iiop://myserver:myport
➤ Messaging Model. The type of JMS message—Point to 

point, or Publish and subscribe.

Attachments pane. Allows you to attach a file to the 
component. For details, see the Quality Center User Guide.

UI Elements (A-Z) Description
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Submit. Creates the component whose details you 
specified.

Close. Closes the dialog box and cancels any changes you 
made to the existing screen.

Component Name A name for the component.

Component Type The type of component to create: General, Web Service, 
or JMS. If you created a custom type component in 
Customization, it also appears in the dropdown list.

UI Elements (A-Z) Description
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Application Components Module Icons 

This section describes the icons available in the Application Components 
module.

The icons are described below: 

To access Click the Application Components button  on the 
Quality Center sidebar. 

See also ➤ "Application Components Module Window" on 
page 48

➤ "Application Components Module Menus and 
Buttons" on page 50

UI Elements Description

Alerts. Click to view a summary of the following alert 
types:

➤ Changes. The component definition has changed.

➤ Rule Violations. The component violates a rule.

For more details, see the "Alerts Dialog Box" on page 28.

Folder. A folder for organizing components. 

Obsolete folder. Contains components that were deleted 
that may affect other components.

General type. A General type application component.

Web Service type. A Web Service type application 
component.

JMS type. A JMS type application component.

Application Component group.
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Application Components Module Window

This page describes the Application Components module window. 

 

User interface elements are described below:

To access Click the Application Components button  on the 
Quality Center sidebar. 

Relevant tasks "Manage component details - optional" on page 80

See also ➤ "Application Components Module Icons" on page 47

➤ "Application Components Module Menus and 
Buttons" on page 50

UI Elements (A-Z) Description

<toolbar and menu> Provides menus and toolbar buttons specific for the 
Application Components module. For details, see the 
"Application Components Module Menus and Buttons" 
on page 50.

<Components Tree> Shows a tree hierarchy of all the components, 
component groups, and folders. For details, see 
"Application Components Module Icons" on page 47.
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Attachments tab Lists the files that have been associated with the selected 
folder, component, or group as attachments. The tab 
includes an icon  if the selected component has 
attachments. For details, see the HP Quality Center User 
Guide.

Details tab Displays general details and attributes of the selected 
component, group, or folder. Displays data that is 
required to identify the component, including the 
creation information. For details, see the "Details Tab" on 
page 29.

Changes tab Lists the changes in the components. It also provides an 
interface to define new changes that you made to the 
components and create test sets to check their impact. 
For details, see "Reporting Changes by Updating 
Components" on page 157.

Interaction tab Provides the component’s contract details, such as the 
WSDL location for Web Services. For details, see the 
"Interaction Tab" on page 32.

Modeling tab Provides an interface to graphically associate 
components with groups, and to define dependencies 
between them. For details, see "Modeling Tab" on 
page 36.

Testing Status tab  Provides a coverage summary for aspects, requirements, 
operations, tests, rule violations, and defects. For details, 
see "Determining Test Coverage" on page 103.

UI Elements (A-Z) Description
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Application Components Module Menus and Buttons

This section describes the menus and buttons available in the Requirements 
module.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access Click the Application Components button  on the 
Quality Center sidebar. 

Important 
information

All menu items are available from the right-click shortcut 
menu.

Relevant tasks "Manage component details - optional" on page 80

UI Elements (A-Z) Menu Description

Toolbar New Folder. Opens the New Folder 
dialog box to create a folder under 
the root or an existing folder.

Toolbar New Component. Displays the last 
button used: New Component or 
New Group.

Toolbar New Group. Displays the last button 
used: New Component or New 
Group.

Toolbar Delete. Deletes selected 
components. Deleting a component 
also deletes its children. You cannot 
delete the root folder.

Toolbar Refresh All. Refreshes the 
Components tree so that it displays 
the most up-to-date versions.

Toolbar Filter/Sort. Enables you to filter and 
sort the requirements in the 
requirements tree or grid. For more 
details, see below.
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Toolbar Send By E-mail. Opens the Send 
E-mail dialog box, enabling you to 
send component URLs and other 
information to recipients from a list 
or to the creator of the component. 
Use this in conjunction with Copy 
URL. For more details, see the HP 
Quality Center User Guide.

Copy URL/Paste Edit Copies a selected component and 
pastes its URL as a link. The 
component itself is not copied. 
Instead, you can paste the address 
into another location, such as an 
e-mail or a document. Clicking the 
link opens Quality Center and takes 
you to the requirement. If you are 
not already logged in, Quality 
Center first prompts for login 
details. 

Copy/Paste Edit Copies selected components within 
the same project or across projects. 
When you copy a folder, its 
sub-folders are copied too.

Notes:

➤ Coverage and modeling data for 
the component are not copied.

➤ If you paste a component that has 
the same name as an existing 
component, the suffix _Copy_x is 
added automatically to the end of 
the name.

Create Empty Test Components Opens the Create Empty Test dialog 
box, prompting you for a location 
and name. This is useful for testers 
who know the required steps, but 
are unfamiliar with the technical 
aspects of creating tests. 

UI Elements (A-Z) Menu Description
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Cut/Paste Edit Moves selected component to a 
different location in the 
Components tree.

Tip: You can also move a component 
to a new location by dragging it.

Delete Edit Deletes the selected component. 

Download Contract File Components Allows you to download a contract 
file from Quality Center to a local 
file system.

Emulation Components Provides access to the Web service 
emulation tools:

➤ Emulate Service. Opens the 
Specify ServiceEmulation Host 
dialog box.

➤ Run Service Emulation Console. 
Opens the console enabling you 
to run the service.

Expand All/Collapse View Expands all or collapses the selected 
branches in the Component tree.

Filter/Sort View Enables you to filter and sort 
application components in the tree. 
For more details, click the Help 
button.

Find Edit Searches for a component in the 
Application Components module. 
For details, see "Find Dialog Box" on 
page 35.

Generate Requirements/
Test

Components Opens the Generate Requirements 
and Test wizard. For details, see 
"Generating Requirements and 
Tests" on page 89.

UI Elements (A-Z) Menu Description
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New Components Enables you to create a new entity:

➤ New Folder. Enables you to create 
a new folder in the Application 
Components tree.

➤ New Group. Opens the New 
Group dialog box.

➤ New Component. Opens the New 
Component dialog box.

Refresh All View Refreshes the Component tree so 
that it displays the most up-to-date 
versions.

Rename Edit Renames the selected entity. You 
cannot rename the root folder.

Syntax exceptions: 

➤ Folder or group names cannot 
include: \*^. 

➤ Component names cannot 
include: \, /, :, ", ?, ', <, >, |, *, %, !, 
{, or }.

Restore Component Components Restores a deleted component from 
the Obsolete folder.

UI Elements (A-Z) Menu Description
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Send by E-mail Components Opens the Send E-mail dialog box, 
enabling you to send URLs and 
other information to recipients from 
a list or to the creator of the 
component. Use this in conjunction 
with Copy URL. For more details, see 
the HP Quality Center User Guide.

Update Component Components Enables you to update a component 
from:

➤ Update Component. Updates the 
component from its original 
location.

➤ Update Component from. Opens 
a dialog box for navigating to a 
URL or a file with an updated 
version of the contract.

UI Elements (A-Z) Menu Description
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Web Services

This chapter includes:

Concepts

➤ Defining Web Services Overview on page 56

➤ Creating Tests in Service Test on page 59

Tasks

➤ How to Define a Web Service on page 60

Reference

➤ Web Service Specific User Interfaces on page 63
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Concepts

Defining Web Services Overview

Web services are a specific case of application components, where the 
contract is a WSDL file, defining the Web service, its address, and the 
operations. Service Test Management’s functionality for application 
components contains several additional features specific to Web Services, 
such as Spot Testing, Service Emulation, and Script Creation with HP Service 
Test.

When working with Web Services, you create a Component hierarchy as 
described in "Creating Application Components Overview" on page 19. 

Web Service contracts are typically WSDL files. Service Test Management 
allows you to import WSDL files that define the Web service and its 
operations.

You can import a definition from a file location, URL, UDDI or Systinet 
server. When you import a definition, Service Test Management extracts the 
service name, service address (endpoint), and data from the definition file, 
and stores it in the Quality Center repository. 

For defining application components that are not WSDL-based, see the 
"New Application Component Dialog Box" on page 43.

If your WSDL is not fully developed, or if the service is currently 
unavailable, you can test with an emulated service. For details, see "Create 
an emulated Web service - optional" on page 61.

This section also includes: 

➤ "Importing Services" on page 57

➤ "Secure Services and Proxy Servers" on page 57

➤ "Spot Testing Operations" on page 58
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Importing Services 
You can import Web service definitions based on WSDL files from a file 
location, URL, UDDI or Systinet server. When importing a WSDL file, 
Service Test Management parses the XML code and stores the service in the 
Quality Center repository.

You can then link the service to other Quality Center entities such as tests, 
test sets, and defects. These links help you to keep track of the service and 
ensure compliance with your requirements throughout the testing process. 
For details about requirement coverage, see "Generating Requirements and 
Tests" on page 89.

You can specify connection settings for WSDL files that reside in secure 
locations or accessible through proxy servers. These settings let you specify 
authentication and proxy server details. Once you enter the security or 
proxy information, it remains permanently associated with the service, 
enabling automatic updates. For details, see "Secure Services and Proxy 
Servers" on page 57.

For user interface details, see the "Import Service Dialog Box" on page 68.

Toolkit Support

When setting up the import, Service Test Management lets you specify a 
toolkit to match the development environment. Service Test Management 
supports the .NET and Axis toolkits. The default Auto-detect option 
attempts to parse the selected WSDLs using the available toolkits, according 
to the parsing order set in Project Customization. 

For details about customizing the toolkit parsing order, see the 
"Customization Overview" on page 133. 

Secure Services and Proxy Servers
When importing WSDL files from a URL or UDDI server, the WSDL may 
require authentication if it resides in a secure location. Certain WSDLs may 
only be accessed through a proxy server. 

Service Test Management supports WSDLs that require authentication and 
WSDLs accessed through proxy servers, using basic and NTLM 
authentication. 
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The security or proxy information is always associated with the WSDL, If 
you enable the Keep up to date option to allow automatic synchronization, 
Service Test Management uses the authentication or proxy server settings to 
access the WSDL at its source.

Note: Setting default connection settings in the project customization area, 
instructs Service Test Management to use the same settings for all your 
services. For details, see "How to Customize a Project" on page 138.

Spot Testing Operations 
The Web Service Call utility lets you test your operations one by one, also 
known as spot testing. This utility lets you check that the operation is 
functional and that its response is valid.
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You use the grid to enter request values and submit them to the server. You 
can view the SOAP response and export it to a file. For details, see "Test the 
service - optional" on page 62.

Creating Tests in Service Test 

If you have HP Service Test, you can create tests to test the components in 
Service Test Management.

In Service Test, use the Tools menu to connect to the same Quality Center 
project that contains your Web Service type components.

Create a Web Services type script in the normal way, and save it to the 
appropriate location in the Quality Center repository.

Use the Components tab in the Test Plan module to link a component to the 
test. For details, see "Application Components Tab - Test Plan Module" on 
page 130. 

For more information, see the HP Service Test User Guide, available from the 
online help’s Home page.
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Tasks

How to Define a Web Service

This task describes how to set up your components in Service Test 
Management. After you set them up, you can test them and check their 
functionality and compliance.

➤ "Create a folder" on page 60

➤ "Create a new component" on page 60

➤ "Import a service" on page 61

➤ "Set authentication or proxy information - optional" on page 61

➤ "Create dependencies - optional" on page 61

➤ "Create an emulated Web service - optional" on page 61

➤ "Test the service - optional" on page 62

Create a folder

The development team and Quality Assurance should design a tree 
hierarchy representing the structure of the application. Open the New 
Folder dialog box and add new folders and subfolders based on your design 
requirements. For details, see the "New Folder Dialog Box" on page 43.

You can create folders at any time and drag or copy components from folder 
to folder. 

Create a new component 

Create a new component. Select Components > New > New Component. For 
details, see the "New Application Component Dialog Box" on page 43.
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Import a service

In the New Component Dialog box, select the Interaction link and click 
Browse to open the Import Service dialog box. For details, see the "Import 
Service Dialog Box" on page 68.

Set authentication or proxy information - optional

If the WSDL file requires authentication or if it accessible through a proxy 
server, click the Connection Settings button to configure the connection 
settings. For details, see the "Connection Settings Dialog Box" on page 66.

Create dependencies - optional

Dependencies indicate the reliance of one component upon another.

 1 Select the Modeling tab. For a description, see the "Modeling Tab" on 
page 36.

 2 Click the Select Entities button to open the Components list in the right 
pane. Expand the folders and select a component.

 3 Click the arrow to open the transfer menu.

 a To add a component that is dependent on the base component, click Add 
Component Dependency (Dependency To).

 b To add a component upon which the base component is dependent, click 
Add Component Dependency (Dependency From).

 4 The Dependency Details dialog box opens. Select the operation that 
affects the dependency. If you do not know which operation to select, 
specify all of them. For details, see the "Dependency Details Dialog Box" 
on page 42.

Create an emulated Web service - optional

If you are working with a Web service component that is unavailable or still 
under development, you can create an emulation of the Web service 
component. This requires an installation of HP Service Test or the Service 
Test Add-in for Quality Center.
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 1 Verify that the host server is active. The host server is the machine to 
which you will be sending the Web Service calls. By default, Service Test 
activates the server upon startup. Enter the following URL into your 
browser:
http://<hostname>:8080/ServiceEmulation/index.jsp. 
If the server is active, the browser will display HP Service Emulation.

 2 If the server is not active, choose Start > All Programs > HP Service Test > 
Start Emulation Service.

 3 Select Components > Emulation > Emulate Service. In the Specify Service 
Emulation Host dialog box, specify the machine to which you will be 
sending the Web Service calls. This can also be the local machine. 

 4 Set up the service emulation. Select Components > Emulation > Run 
Service Emulation Console. Configure the rules as required, For more 
information, see the HP Service Test User Guide, available through the 
online help’s Home page.

Test the service - optional

To generate a Web Service call in order to test your Web Service, click the 
Interaction tab, select an operation, and click Web Service Call. In the grid, 
enter request values. Send the request to the server and check the SOAP 
response. For details, see the "Run <Operation> Dialog Box" on page 69.

Run the test 

After you verify that your service is valid, run the test or test set as you 
would run any test in Quality Center, from the Test Lab module. For details, 
see the Quality Center User Guide.

The manual running option provides an interface for working with Web 
Services. For details, see the "Manual Runner Service Testing Tab" on 
page 71.
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Reference

Web Service Specific User Interfaces

Service Test Management provides a user interface to import Web Service 
contracts and test the Web Service Calls.

This section includes (in alphabetical order):

 ➤ Select Service from Systinet Dialog Box on page 63

 ➤ Select Service from UDDI Dialog Box on page 64

 ➤ Connection Settings Dialog Box on page 66

 ➤ Import Service Dialog Box on page 68

 ➤ Run <Operation> Dialog Box on page 69

 ➤ Manual Runner Service Testing Tab on page 71

 ➤ Specify Service Emulation Host Dialog Box on page 75

Select Service from Systinet Dialog Box

Enables you to select and import services from a Systinet server.

To access In the Import Service dialog box, choose Import WSDL 
from: Systinet and click the Browse  button.

Relevant tasks "Import a service" on page 61

See also ➤ "Import Service Dialog Box" on page 68

➤ "Select Service from UDDI Dialog Box" on page 64
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The following elements are included:

Select Service from UDDI Dialog Box

Enables you to select and import services from a UDDI (Universal 
Description, Discovery, and Integration) server.

UI Elements (A-Z) Description

Reloads the list of the services on the Systinet server, in 
the Available Services pane.

Filters the list of services to show only those services 
containing the string specified in the Service name field.

Systinet Address The name or IP address of the Systinet server. 

For Example: http://lab3.devlab.ad:8080/soa

Environment The Systinet environment and version.

Service name A string in the service name by which to filter the list.

Available Services A list of the services that match the filter criteria in 
alphabetical order. The grid shows the following 
information:

➤ Component Name

➤ Component ID

➤ Description

➤ Contract File

➤ UUID (Universally Unique Identifier)

To access In the Import Service dialog box, choose Import WSDL 
from: UDDI and click the Browse  button.

Relevant tasks "Import a service" on page 61

See also "Select Service from Systinet Dialog Box" on page 63
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The following elements are included:

UI Elements (A-Z) Description

Reloads the list of the services from the UDDI, in the 
Available Services pane.

Filters the list of services to show only those services 
containing the string specified in the Service name field.

UDDI address The name or IP address of the UDDI server inquiry API.

For Example: http://lab1.devlab.ad:8090/juddi/inquiry.

Environment The UDDI version—2 or 3.

Service name A string in the service name by which to filter the list.

Available Services A list of the services that match the filter criteria. The 
grid shows the following information:

➤ Component Name

➤ Component ID

➤ Description

➤ Contract File

➤ UUID (Universally Unique Identifier)
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Connection Settings Dialog Box

Enables you to provide authentication credentials and proxy server details 
for the machine hosting a Web Service’s WSDL file.

To access ➤ For a new service: In the New Component window 
(Components > New > New Component), select the 
Interaction node and click Browse. Click the 
Connection Settings button.

➤ For existing services: Select the Interactions tab, click 
Update From, and click Connection Settings.

➤ In Customization: Service Test Management link > 
General Tab > Edit Default Settings

Important 
information

Only available for services imported through a URL and 
UDDI.

Relevant tasks "Import a service" on page 61

See also You can set the default WSDL connection settings in the 
Project Customization window. For details on 
customizing the connection settings, see "Customizing 
Service Test Management" on page 133.
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The following elements are included:

UI Elements (A-Z) Description

Authentication Access the WSDL located in a secure location, using the 
following authentication credentials. enables you to 
enter credentials for authentication

➤ Use default credentials. authenticates with the 
Windows logon credentials of the user logged on to 
the machine

➤ User name, Password. the user name and password to 
be used for authentication. For users not in the default 
domain, type the domain name before the user name. 
For example, domain1/alex_qc.

Proxy Access the WSDL using the following proxy server and 
credentials. Enables you to enter proxy details and 
credentials:

➤ Proxy server. Name or IP address of proxy server.

➤ Port. Port through which to access the WSDL.

➤ Use default credentials. Connects to the proxy server 
with the Windows logon credentials of the user logged 
on to the machine.

➤ User name, Password. The user name and password to 
be used for authentication. For users not in the default 
domain, type the domain name before the user name. 
For example, domain1/alex_qc.

Restore Defaults Restores the default connection settings—user name 
authentication and no proxy server.
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Import Service Dialog Box 

For Web Service type application components, this dialog box enables you 
to import WSDLs from a file system, a URL, a UDDI, or Systinet.

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

To access In the New Application Component window 
(Components > New > New Component), select the 
Interaction link. Click Browse. 

Relevant tasks "Import a service" on page 61.

See also ➤ "Connection Settings Dialog Box" on page 66

➤ "Select Service from Systinet Dialog Box" on page 63

➤ "Select Service from UDDI Dialog Box" on page 64

UI Elements (A-Z) Description

Lets you locate the WSDL by opening one of the 
following:

➤ File. An Open File dialog box

➤ URL. A new browser window

➤ Systinet. Select Service from Systinet dialog box

➤ UDDI. Select Service from UDDI dialog box 

Opens the Connections Settings dialog box for 
configuring the authentication and proxy settings of the 
server hosting the WSDL. For details, see "Connection 
Settings Dialog Box" on page 66.
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Run <Operation> Dialog Box 

This dialog box enables you to run a spot test for an individual operation. 
You can set up a request and view the SOAP response to verify if an 
individual operation is functional.

User interface elements are described below.

Import WSDL from The WSDL source:

➤ File. The file system

➤ URL. A URL

➤ Systinet. A Systinet registry

➤ UDDI. A UDDI server

WSDL Location Location of WSDL:

➤ File: full path and file name

➤ URL: Complete URL 

➤ Systinet: Systinet ID

➤ UDDI: Server key

To access Select an operation in the Interaction tab and click the 
Web Service Call  button. 

Important 
information

You must have the Service Test add-in to use this utility.

Relevant tasks "Test the service - optional" on page 62.

UI Elements (A-Z) Description

End Point The address of the server over which to submit the 
request.

UI Elements (A-Z) Description
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Run Operation - Request Pane

User interface elements are described below:

Request Pane The request values and controls. For details, see the "Run 
Operation - Request Pane" on page 70.

Response Pane The SOAP response. For details, see the "Run Operation - 
Response Pane" on page 71.

UI Elements (A-Z) Description

Sends the request to the server address specified in the 
End Point box.

Clears the values you assigned to the arguments in the 
Grid tab.

Allows you to import an XML structured file, for the 
purpose of loading values for the request.

Allows you to export the values in the grid to an XML 
file, for the purpose of reusing them at a later stage.

Grid Tab A list of all arguments, and a column for setting their 
values. Click on a triangle adjacent to an argument to 
include/exclude it from the request.

➤ A filled-in triangle includes the argument in the 
request; An empty triangle excludes the optional 
argument from the request.

➤ An argument with an ABC icon can be parameterized.

➤ A NIL icon indicates that argument can have a NIL 
value.

Security Tab The security policy:

➤ No Security Options. Do not use any security (default).

➤ Use Authentication Settings. Authenticate using a user 
name, password, and password send option—
PlainText, None, or Hashed.

➤ Use Kerberos. Use the Kerberos token security

UI Elements (A-Z) Description
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Run Operation - Response Pane

User interface elements are described below:

Manual Runner Service Testing Tab

This tab lets you manually run a Web Service test step. 

You can verify the functionality of a specific operation using Spot testing. 
For details, see "Spot Testing Operations" on page 58.

SOAP Tab The request submitted to the server in SOAP format.

XML Tab The request submitted to the server in XML format.

UI Elements (A-Z) Description

Enables you to export the SOAP response to an XML file.

SOAP Tab SOAP response resulting from the request.

To access Perform the following steps:

➤ Select a test set in the Test Lab module and click the 
Execution Grid tab. 

➤ Select a test and choose Run > Run Manually. 

➤ Click the Service Testing tab.

Important 
information

You must have the Service Test add-in or an installation 
of HP Service Test to view this tab.

Relevant tasks "Test the service - optional" on page 62

See also "Create an empty test - optional" on page 95

UI Elements (A-Z) Description
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User interface elements are described below.

UI Elements (A-Z) Description

Previous Step. Navigates to the previous test step.

Next Step. Navigates to the next test step.

Set Pass Status. Sets the test status to Pass. The drop 
down list provides the following options:

➤ Pass Selected. Sets status to Pass for selected steps.

➤ Pass All. Sets status to Pass for all steps of the test.

Set Fail Status. Sets the test status to Fail. The drop down 
list provides the following options:

➤ Fail Selected. Sets status to Fail for selected steps.

➤ Fail All. Sets status to Fail for all steps of the test.

Opens the New Defect dialog box for creating a defect for 
the current test and test set. 

Add Attachment to Run. Adds an attachment to the test 
run. An attachment can be a file, URL, snapshot of your 
application, an item from the clipboard, or system 
information. The drop down list provides the following 
options:

➤ Attachment to Step. Adds an attachment to the 
current step.

➤ Attachment to Run. Adds an attachment to all 
steps.

Stop run. Terminates the manual test run. 

Actual Result The actual value returned. If this value matches the 
Expected Value, mark the status to Pass. Otherwise, set 
the status to the appropriate value.

For a Web service step, use the Send Request button to 
check the response. See "Manual Runner - Service Testing 
Tab Request Pane" on page 73.
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Manual Runner - Service Testing Tab Request Pane

User interface elements are described below:

Available Services 
and Operations

A list of all services and operations available for the test.

Description An editable description of the test step.

End Point The address of the server over which to submit the 
request. Specify a path to override the WSDL’s default.

Expected Result The value you expect the server to return.

Request Pane The request values and controls. For details, see the 
"Manual Runner - Service Testing Tab Request Pane" on 
page 73.

Response Pane The SOAP response. For details, see the "Manual Runner - 
Service Testing Tab Response Pane" on page 74.

Status The status you want to manually assign to the test: Fail, 
N/A, No Run, Not Completed, or Pass.

Step The step number whose details are displayed.

UI Elements (A-Z) Description

Sends the request to the server address specified in the 
End Point box. 

Before sending the request, select the desired operation 
in the Available Services and Operations pane. In the 
Grid tab, provide argument values. If required, modify 
the XML and then send the request.

Clears the values you assigned to the arguments in the 
Grid tab.

Enables you to import the request data from an XML file.

UI Elements (A-Z) Description
73



Chapter 3 • Web Services
Manual Runner - Service Testing Tab Response Pane

User interface elements are described below:

Enables you to export the request to an XML file.

Grid Tab Contains a list of all arguments, and a column for setting 
their values. Click on a triangle adjacent to an argument 
to include/exclude it from the request.

➤ A filled-in triangle includes the argument in the 
request; An empty triangle excludes the optional 
argument from the request.

➤ An argument with an ABC icon can be parameterized.

➤ A NIL icon indicates that argument can have a NIL 
value.

Security Tab Connection and Authentication information required for 
performing the Web Service call.

SOAP Tab The request submitted to the server in SOAP format.

XML Tab The request submitted to the server in XML format.

UI Elements (A-Z) Description

Enables you to export the SOAP response to an XML file.

SOAP Tab SOAP response resulting from the request.

UI Elements (A-Z) Description
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Specify Service Emulation Host Dialog Box

Enables you to select a host machine and port for your emulated service. 

The following elements are included:

To access Components > Emulation > Emulate Service.

Important 
information

The host machine must have the Tomcat server. This is 
installed automatically on the localhost with Service Test 
or the Service Test add-in.

Relevant tasks "Create an emulated Web service - optional" on page 61

See also For more information, see the Service Test User Guide.

GUI Element (A-Z) Description

Browse. Opens the Browse for Computer dialog box.

Host Name The name or IP address of the machine to host the 
emulated service.

Port The port number for the specified host machine

Default value: 8080

Tip: If you have a conflict with the 8080 port, edit the 
Server.xml file in the apache-tomcat-5.5.17\conf folder. 
Change the port from 8080 to another port. Create a new 
localhost server with the new port number.
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Managing Components in Quality Center

This chapter includes:

Concepts

➤ Managing Components on page 77

Tasks

➤ How to Manage Components on page 80

Concepts

Managing Components

After you define an application component, you can view and modify its 
definitions and details. You can also resolve alerts and view the changes on 
your component. Using the Components tree, you can reorganize the 
components under different folders. 

This section includes:

➤ "Component Details" on page 78

➤ "Locating Components" on page 78

➤ "Handling Rule Violations or Change Alerts" on page 78

➤ "Copying Components" on page 79

➤ "Attachments" on page 79

➤ "Restoring and Removing Components" on page 79

➤ "E-mailing Components" on page 80
77



Chapter 4 • Managing Components in Quality Center
Component Details
In the Components tree, you can view and modify the location of 
components and folders. For Web service components, you can view 
information such as the WSDL location, override the service address, and 
modify connection settings.

For details, see "Manage component details - optional" on page 80.

Locating Components
You can search for a particular entity in the Components tree—folder, 
component, or group, by one of their Details tab fields. The search utility 
allows wildcards and searching by a specific field. For example, you can 
search for a component that begins with the letter "s".

Tip: If you applied a filter to the tree, the search is restricted to the folders 
and components currently displayed.

For details, see "Find folders and components - optional" on page 81.

Handling Rule Violations or Change Alerts
Service Test Management uses alert indicators to make you aware of changes 
to the components or rule violations. 

The changes can be those entered manually or those detected automatically 
by Service Test Management when you update a contract. 

Rule violations are a result of non-compliance with the component’s 
requirements. To complete your testing, you should try to resolve the alerts. 

For additional information, see "Handle alerts - optional" on page 81.
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Copying Components
You can copy an existing folder, component, or group and paste it to 
another location in the Components tree, or to another project. When 
copying a component to another project, the source and target projects 
must be open in separate browsers.

For additional information, see "Copy entities - optional" on page 81.

Attachments
The Attachments tab enables you to associate an attachment with a folder, 
component, or group. An attachment can be a file, URL, text from the 
clipboard, snapshot, or system information. It is identified by its name, 
associated application icon, size, and latest modification date and time. You 
can add, modify, and delete attachments.

The Attachments tab includes an icon  if the selected folder, component, 
or group has any attachments.

The Attachments tab for folders, components, and groups has the same 
functionality as the Attachments tab for other types. For details on adding 
attachments, refer to the HP Quality Center User Guide.

Restoring and Removing Components
You can permanently delete folders or components that are not used by a 
test or requirement. To see if a component is used by a test, see "Tests 
Coverage" on page 108. If you try to delete components that are used by one 
or more tests, Quality Center transfers them to the Obsolete folder. You 
cannot copy obsolete components.

You can restore components in the Obsolete folder to their original position 
in the Components tree if the folder still exists in the tree, or you can drag 
them to a different location in the tree.

For details, see "Restoring and Removing Components" on page 79.
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E-mailing Components
You can send e-mail about an entity (folder, component, or group) to other 
users. This enables you to routinely inform users about the status of your 
components. A link is included in the e-mail message that enables the 
recipient to go directly to the component. You can also include your own 
shortcuts using one of the formats described in "Quality Center Direct Links" 
on page 26.

For additional information, see "Mail components- optional" on page 82.

Tasks

How to Manage Components

This task describes how to work with your components by changing its 
details, updating a WSDL, resolving alerts, copying entities, and so forth.

This task includes the following steps:

➤ "Manage component details - optional" on page 80

➤ "Find folders and components - optional" on page 81

➤ "Handle alerts - optional" on page 81

➤ "Copy entities - optional" on page 81

➤ "Remove and restore components - optional" on page 82

➤ "Mail components- optional" on page 82

Manage component details - optional

Open the Details tab and modify the component details as required.

For more information, see the "Details Tab" on page 29.
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Find folders and components - optional

 1 To search all of the application components, select Filter > Clear Filter to 
remove any filters.

 2 Select Edit > Find. The Find dialog box opens.

 3 Select an Entity Type: Folder, Application Component, or Group. 

 4 Select the field to search in the Find in Field box. For example to search for 
a component by its name, select Component Name field and specify a 
part or the whole name as a value.

 5 Specify a value in the Value to Find box. The search engine is not 
case-sensitive and it finds parts of a string.

 6 Click Find Next to locate the first and subsequent matches.

For details, see the "Find Dialog Box" on page 35.

Handle alerts - optional

Click on an exclamation point adjacent to a component, to view its alerts. 
Determine which alerts to resolve. For details, see the "Alerts Dialog Box" on 
page 28.

Copy entities - optional

Using the right-click shortcut menu, copy an existing folders, components, 
or groups onto the clipboard. Open the target folder in the Component tree 
and paste the entity from the clipboard. To copy to another project, open it 
in another browser.

For details, see the "Application Components Module Window" on page 48.
81



Chapter 4 • Managing Components in Quality Center
Remove and restore components - optional

To remove a component, select it and click the Delete button. If you remove 
a folder, its subfolders and all components in those folders are removed too. 
If a removed component is still being used by an existing test, Service Test 
Management stores it in the Obsolete folder.

To remove a component entirely, make sure that no tests are using it. Click 
the Test Script tab in the Test Lab module to open the test in Service Test, 
and remove all steps calling the component. After you have removed all 
calls to the component, delete it from the Obsolete directory. 

You can restore components in the Obsolete folder to their original position 
in the Components tree, if the folder still exists in the tree. If the folder no 
longer exists, transfer the component to another position in the tree by 
dragging it from the Obsolete folder to the desired location.

Mail components- optional

Select a component and click the Send by e-mail button . A link included in 
the e-mail message enables the recipient to go directly to the component.

Edit the content, select recipients, and perform a spell check. For details 
about the Send Mail dialog box, click F1 or see the HP Quality Center User 
Guide.
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Groups

This chapter includes:

Concepts

➤ Groups Overview on page 83

Tasks

➤ How to Manage Component Groups on page 85

Reference

➤ New Groups User Interface on page 87

Concepts

Groups Overview

In an organization, application components have a context. For example, 
the components may be located on the same server, may be exposed as part 
of the same application, or may take part in the same business process.

In the Application Components module, you use groups to organize your 
components into logical groupings. You might, for example, organize them 
into groups representing different physical deployments, business processes, 
or application types such as Enterprise Resource Planning (ERP) or Customer 
Relationship Management (CRM). After you create the groups, you can 
associate components to them, and perform tasks upon all members of the 
group. 
83



Chapter 5 • Groups
You can add attachments to a group and send e-mails in a similar manner to 
that of individual components. For details, see the HP Quality Center User 
Guide.

This section also includes:

➤ "Associating Components to Groups" on page 84

➤ "Group Coverage" on page 85

Associating Components to Groups 
Groups help you organize your components into logical units. You might, 
for example, organize them into groups representing different physical 
deployments, business processes, or application types. After you create 
groups, you can associate components to the group, and perform tasks upon 
the entire group. The same component can be assigned to multiple groups.

The Modeling tab lets you create and view the associations between the 
groups and components. For details, see the "Modeling Tab" on page 36.
84



Chapter 5 • Groups
Group Coverage 
You define requirements and tests for individual components—not for 
groups. When you associate components with groups, the group reflects the 
coverage of all its associated entities. You can view the complete coverage in 
the group’s Testing Status tab. Click any of the sections in the Testing Status 
tab, to see the specific coverage for aspects, requirements, or tests.

For details, see Chapter 7, "Determining Test Coverage."

Tasks

How to Manage Component Groups

This task describes how to create and manage component groups. It also 
describes how to associate components to a group and how to check the 
testing coverage for the entire group.

This task includes the following steps:

➤ "Create an application component group" on page 86

➤ "Add a component to a group" on page 86

➤ "View and Modify Group Details - optional" on page 86
85



Chapter 5 • Groups
➤ "Mail Group Information - Optional" on page 86

➤ "Results and Coverage" on page 87

Create an application component group

Create a group at the root level of the component or under a specific folder. 
Quality Center displays the groups in the Component tree hierarchy. For 
details, see "New Group Dialog Box" on page 87.

Add a component to a group

 1 Select a group in the Application Components tree.

 2 Click the Modeling tab. 

 3 Click Select in the Modeling tab to open the Application Component 
folders in the right pane. 

 4 Expand the tree and select the application component you want to add to 
the group.

 5 Click Add > Associate to add the component to the group.

For more details, see the "Modeling Tab" on page 36

View and Modify Group Details - optional 

Select a group in the Application Components tree and click the Details tab.

For further information, see the "Details Tab for Groups" on page 31.

Mail Group Information - Optional 

Send Group details by e-mail to other users. This enables you to routinely 
inform users about the status of a group and its components. The e-mail 
message includes a link that enables the recipient to go directly to the 
group. 

For more information about sending e-mails directly from Quality Center, 
see the Quality Center User Guide. 
86



Chapter 5 • Groups
Results and Coverage

Click the Testing Status tab to view the complete coverage for aspects, 
requirements, or tests of the group’s components.

For details, see Chapter 7, "Determining Test Coverage."

Reference

New Groups User Interface 

This section includes:

 ➤ New Group Dialog Box on page 87

New Group Dialog Box

Enables you to create a new group.

The following elements are included:

To access Use one of the following:

➤ Select Components > New > New Group

➤ Select New > New Group from the shortcut menu

Relevant tasks "Create an application component group" on page 86

GUI Element (A-Z) Description

Clear All. Clears all the fields in the dialog box so that 
you can redefine the group.

Details module. Enables access to the Details and 
Description tabs.

Attachments module. Lets you attach a file to the group. 
For details, see the Quality Center User Guide.
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Submit. Creates the group whose details you specified.

Close. Closes the dialog box and cancels any changes you 
made to the existing screen.

Description tab A description of the group’s objective.

Details tab Lets you set the following fields:

➤ Assigned To

➤ Created By

➤ Creation Date

Name The name you assigned to the group.

GUI Element (A-Z) Description
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Generating Requirements and Tests 

This chapter includes:

Concepts

➤ Generating Requirements and Tests Overview on page 89

Tasks

➤ How to Generate Requirements and Tests on page 94

Reference

➤ Generate Requirements and Tests User Interface on page 95

Concepts

Generating Requirements and Tests Overview 

To test your application, you can manually create requirements and tests, or 
use the Requirement and Test Generation wizard to automatically generate 
requirements and test scripts.

The Requirement and Test Generation wizard guides you through the 
process of creating requirements and scripts to test your application 
components. Through the wizard, you indicate which aspects of the 
component you want to test. These aspects include interoperability with 
different toolkits, boundary testing, and standard compliance.
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After you select the testing aspects, Service Test Management generates a set 
of requirements, or requirements and tests linked to the component or to 
components in the group. Only requirements are linked to components. 
The tests are indirectly linked to components through requirements. These 
requirements and tests provide pre-packaged testing methodologies and 
component information that specify which components of the application 
need to be tested, and what to test in each part. 

Generated requirements provide a textual description of the testable feature 
and the expected behavior, based on a template of the specified testing 
aspects adapted to the selected components. Generated tests describe the 
test objective and provide an implementation of that testing objective. They 
include the test operations and arguments for specific testing types. After 
generating requirements and tests, you should customize them to your 
particular requirements.

You can also link components to manually created requirements, and 
indirectly to tests through requirements. For details on assigning 
components to requirements and tests, see "Linking Components and 
Requirements" on page 123

This section also includes:

➤ "Testing Aspects" on page 91

➤ "Empty Tests" on page 93

➤ "Actions after Creating a Test" on page 93
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Testing Aspects 
The Requirement and Tests Generation wizard helps you create 
requirements and tests that verify different aspects of your component. 
Service Test Management creates a separate requirement for each aspect and 
child aspect, and a separate test for each child aspect.

The following table lists the built-in testing aspects:

Aspect Name Description

Positive Testing Generates a full positive test that checks each operation 
of the component.

Standard Compliance Checks the component’s compliancy with industry 
standards such as WS-I and SOAP.

Service 
Interoperability

Tests the interoperability of the component’s operations 
with all supported technological platforms.

Tests that the component is fully interoperable with all 
supported technological platforms, by calling all of its 
operations with default or expected values.

For Web Services, it contains the following sub-aspects:

➤ .NET Framework. Tests that the service is fully 
interoperable with .NET Framework WSE 2 toolkit. 

➤ Axis/Java Based Web Services. Tests that the service is 
fully interoperable with Axis 1.3 Web Services.

Security Testing Tests security. Contains the following sub-aspects:

➤ SQL Injection Vulnerability. Checks if the component 
is vulnerable to SQL injections by injecting SQL 
statements and errors into relevant parameters. 

➤ Cross-site Scripting (XSS). Attempts to hack the 
component by injecting code with relevant 
parameters that will disrupt its functionality.
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You can also define custom aspects. For details, see the Customization’s 
"Aspects Tab" on page 145.

Boundary Testing Using the negative testing technique, creates tests to 
manipulate data, types, parameters, and the actual SOAP 
message to test the component to its limits.

Contains the following sub-aspects:

➤ Extreme Values. Provides invalid data types to the 
components and verifies they are not accepted. 

➤ Null Values. Provides NULL parameters to the 
components to verify they are not accepted.

Performance Testing Contains the following sub-aspects:

➤ Stress Testing. Tests the maximum load that can be 
placed on the application.

➤ Overload Sustainability Testing. Tests how well the 
hardware allocated for the application can support the 
number of anticipated users. 

➤ Volume Testing. Tests that the system can handle a 
massive data entry. 

➤ Longevity Test. Tests that the system can sustain a 
consistent number of concurrent users and executing 
transactions using near-peak capacity, over a 
minimum 24-hour period. 

➤ Scalability Testing. Repeated stress, overload, volume, 
and longevity tests with different server or network 
hardware configurations.

Aspect Name Description
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Empty Tests
After you create a component in the Application Components module, you 
can create an empty test, edit it, and assign it to requirements at a later 
stage. For details on creating tests, see "Create Empty Test Dialog Box" on 
page 96.

Actions after Creating a Test
After generating requirements or requirements and tests, you can do the 
following:

Action Description

Edit the generated 
requirements

You can modify the details, attachments, component 
coverage, test coverage, and defect links for any 
requirement to suit your specific testing objectives. For 
example, you might want to define customized thresholds 
that are not reflected in your component definitions. For 
details about defining requirements, refer to the 
HP Quality Center User’s Guide.

Edit the generated 
tests

You can edit the generated scripts to expand their scope 
and purpose. You can edit manual tests, scripts designed 
with Service Test, or those created by a third-party vendor. 

Configure run-time 
settings for test 
instances

You can view the script’s run-time settings, and configure 
run-time settings for test instances in the Test Lab 
module. For details, refer to the HP Quality Center User’s 
Guide.

Configure 
parameters for test 
instances

You can configure parameters for test instances in the Test 
Lab module. For details, refer to the HP Quality Center 
User’s Guide.

Manually set 
requirements

You can manually set requirements for a component. For 
details on linking components to requirements, see 
"Linking Components and Requirements" on page 123.
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Tasks

How to Generate Requirements and Tests

This task describes how to create requirements or tests for checking the 
quality of your component. 

This task includes the following steps:

➤ "Prerequisites" on page 95

➤ "Run the wizard - optional" on page 95

➤ "Review the generated tests" on page 95

➤ "Create an empty test - optional" on page 95

➤ "Remove unwanted tests or requirements - optional" on page 95

Manually add test 
coverage

You can manually add test coverage for a component. For 
details, see "Linking Components and Requirements" on 
page 123

Run the test Run the test from Quality Center’s Test Lab module. For 
details, see the Quality Center User Guide. 

Action Description
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 1 Prerequisites

Make sure you have at least one component in the Components tree. If 
not, use the Components menu to create one. Select the component for 
which you want to create requirements or tests.

 2 Run the wizard - optional 

To automatically create test scripts, select Components > Generate 
Requirements/Tests to open the wizard. For details, see the "Generate 
Requirements and Tests Wizard" on page 97.

 3 Review the generated tests

After the generation process, you can review the generated entities in the 
Testing Status tab. This tab also provides full coverage information for 
each requirement and test. For details, see Chapter 7, "Determining Test 
Coverage."

 4 Create an empty test - optional

If your component is not ready yet, you can create an empty test and 
modify it at a later point. Select Components > Create Empty Test.

 5 Remove unwanted tests or requirements - optional

To remove a test or requirement, select it in the Testing Status tab and 
click the Delete button. For details, see Chapter 7, "Determining Test 
Coverage."

Reference

Generate Requirements and Tests User Interface 

This section includes:

 ➤ Create Empty Test Dialog Box on page 96

 ➤ Generate Requirements and Tests Wizard on page 97
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Create Empty Test Dialog Box 

This dialog enables you to create an empty test for a component.

User interface elements are described below:

Select Test Folder Dialog Box

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access Components > Create Empty Test 

Relevant tasks "Create an empty test - optional" on page 95

UI Elements Description

Opens the Select Test Folder Dialog Box.

Test Name The name of the test as it will appear in the Tests tree and 
repository.

Test Folder The folder under which to create the tests.

UI Elements (A-Z) Description

Refresh the Tests list.

Set or clear a filter for the Tests list.

Create a new folder.

<Test Folder list> A list of the test folders in the tree hierarchy. Use the 
expand and collapse buttons to show or hide the folder 
contents.
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Generate Requirements and Tests Wizard 

This wizard enables you to create requirements and/or tests for your 
component.

Select Entities Page 
This wizard page enables you to indicate which entities to create: 
requirements and tests, tests only, or requirements only.

To access Components > Generate Requirements/Tests 

Relevant tasks "Generate Requirements and Tests Wizard" on page 97

Wizard map This wizard contains:

Select Entities Page > Select Aspects Page > Select 
Locations Page > Summary Page> Generate Page

See also ➤ "View the Requirements coverage - optional" on 
page 110

➤ "View the Tests coverage - optional" on page 111

Important 
information

General information about this wizard is available here: 
"Generate Requirements and Tests Wizard" on page 97.

Wizard map This wizard contains:

Select Entities Page > Select Aspects Page > Select 
Locations Page > Summary Page> Generate Page
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User interface elements are described below:

UI Elements (A-Z) Description

Generate The entities to generate:

➤ Requirements and tests. Generates a set of 
requirements, and tests that are indirectly linked to 
the component through the requirements. The tests 
describe the test objective, based on a template of 
the specified testing aspects. Whenever possible, 
generated tests provide an implementation of the 
test objective by describing the test operations.

➤ Tests only. Generates a set of tests for the aspects 
you select in the next step. The tests are indirectly 
linked to the component via the component's 
default requirement.

➤ Requirements only. Generates a set of requirements 
for the selected component.

Select Script 
Generator

The engine to use for generating a test.

➤ Manual Test. Creates manual tests with no design 
steps. This is available for all application 
component types.

➤ HP Service Test. Creates tests based on an 
installation of Service Test or the Service Test add-in 
for Quality Center. See the Installation Guide for 
details (only available for Web Service type 
components).

➤ <custom generator>. Creates tests based on a 
custom generator. For details, see "Custom Script 
Generators" on page 185.
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Select Aspects Page
This wizard page enables you to select testing aspects for which to create the 
requirement and tests.

User interface elements are described below:

Important 
information

General information about this wizard is available here: 
"Generate Requirements and Tests Wizard" on page 97.

Wizard map This wizard contains:

Generate Requirements and Tests Wizard > Select 
Aspects Page > Select Locations Page > Summary Page> 
Generate Page

See also ➤ "Customizing Service Test Management" on page 133

➤ "Custom Script Generators" on page 185

UI Elements (A-Z) Description

Clear aspect. Excludes the aspect.

Select Aspect. Includes the aspect. If you select a parent, 
all of its children are included.

Covered aspects A tree view of all the aspects available for your 
components. Use the Expand and Collapse  
buttons to show or hide all of the aspects.
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Select Locations Page 
This wizard page enables you to indicate which entries to create: 
requirements and tests, tests only, or requirements only.

User interface elements are described below:

Summary Page 
This wizard page provides a summary of the tests and requirements that are 
to be generated.

Important 
information

General information about this wizard is available here: 
"Generate Requirements and Tests Wizard" on page 97.

Wizard map This wizard contains:

Select Entities Page > Select Aspects Page > Select 
Locations > Summary Page > Generate Page

UI Elements (A-Z) Description

Browse. Locate a parent requirement or test folder.

<parent 
requirement>

Generate requirements as children of the selected 
requirement.

<tests folder> Generate tests under the selected test folder.

Important 
information

When you click Next in this screen, the wizard begins 
generating the requirements and tests.

Wizard map This wizard contains:

Select Entities Page > Select Aspects Page > Select 
Locations Page > Summary Page > Generate Page
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The summary sections are described below:

Generate Page 
This wizard page enables you to select locations to store the generated 
entities: a parent requirement (for generated requirements) and a test folder 
(for generated tests).

User interface elements are described below:

UI Elements (A-Z) Description

Covered aspects A list of the aspects you selected in the Testing Aspects 
screen.

Generated 
requirements will be 
stored as children 
of…

The parent requirement under which the new 
requirements will be generated.

Test destinations The folder under which the tests will be generated.

Important 
information

General information about this wizard is available here: 
"Generate Requirements and Tests Wizard" on page 97.

Wizard map This wizard contains:

Select Entities Page > Select Aspects Page > Select 
Locations Page > Summary Page > Generate Page

UI Elements (A-Z) Description

Closes the wizard. 
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Generate grid A grid containing a list of the requirements and tests that 
were generated. The grid contains the following columns:

➤ Entity type: Requirement or Test.

➤ Generation status: Passed or Failed

➤ Testing aspect: See "Testing Aspects" on page 91.

➤ Component: Component name

Generation Status 
Details

Provides the reasons for failed generation of 
requirements or tests.

UI Elements (A-Z) Description
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Determining Test Coverage

This chapter includes:

Concepts

➤ Coverage Overview on page 104

➤ Rule Violations on page 104

➤ Aspect Coverage on page 105

➤ Requirements Coverage on page 106

➤ Operations Coverage on page 107

➤ Tests Coverage on page 108

➤ Defects Coverage on page 109

Tasks

➤ How to Check the Testing Status on page 109

Reference

➤ Testing Status Tab on page 112
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Concepts

Coverage Overview 

You analyze the quality of your application components using charts that 
display the status of the testing elements: aspects, requirements, tests, 
operations, and defects. You can analyze either a specific component or all 
the components in a group or folder.

The Testing Status tab shows the coverage of the requirements and tests as 
they were defined for the components.

This section also includes:

➤ "Rule Violations" on page 104

➤ "Aspect Coverage" on page 105

➤ "Requirements Coverage" on page 106

➤ "Operations Coverage" on page 107

➤ "Tests Coverage" on page 108

➤ "Defects Coverage" on page 109

Rule Violations

The Testing Status > Rules tab shows you the rules that were violated by the 
component.

The following table describes the rule violations. 

Requirement Status Description

Rule Name The name given to the rule.

Rule Description A description of the rule.
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For task details, see "View the Rule Violations - optional" on page 111.

Aspect Coverage

The Testing Status Aspects tab lets you see the coverage of the Testing 
aspects defined for the component testing. This information is dynamic and 
displays the current testing status in percentages. It is useful for the business 
analyst or system architect who want to see the coverage in meaningful 
terms.

The following table describes the aspect statuses.

Aspect Status Description

All Failed All the aspect’s requirements are assigned the Failed 
status.

Some Failed At least one of the aspect’s requirements is assigned 
the Failed status.

All Passed All the aspect’s requirements are assigned the 
Passed status.

Some Passed At least one of the aspect’s requirements is assigned 
the Passed status. All other requirements have 
either the No Run, Not Completed, or Not Covered 
status.

No Run/Not Completed All the aspect’s requirements are assigned either the 
No Run, Not Completed or Not Covered status.

Not Covered All the aspect’s requirements are assigned the Not 
Covered status.
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Requirements Coverage

Requirement coverage is used to connect components to other Quality 
Center entities (tests, test sets, and defects) through the requirement. This 
helps you keep track of the relationship between your requirements and 
components, and ensures compliance with your requirements throughout 
the testing process. After you have created tests, you associate assigned 
requirements with tests and defects. In this way, you can keep track of your 
testing needs at all stages of the testing process. If a requirement changes, 
you can immediately identify which tests and defects are affected, and who 
is responsible.

To test application components in Service Test Management, you must link 
them to requirements. When you define a component, you can link it to an 
existing requirement or create new requirements. 

To use existing requirements, you drag them from the Requirement entities 
tree to your component. 

To create new requirements, use the Requirement and Test Generation 
wizard as described in "Generating Requirements and Tests" on page 89.

The Testing Status > Requirements tab lets you see the coverage of the 
requirements that were linked to the component. This information is 
dynamic and displays the current status in percentages. It is most useful for 
advanced users who understand the Quality Center coverage model and 
want to integrate application components into that model.
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The following table describes the requirement statuses. 

To manually link requirements to components, see Chapter 8, "Linking 
Components and Requirements."

Operations Coverage

The Testing Status > Operations tab lets you see the coverage for the 
components, per its operations. This information is dynamic and displays 
the current status in percentages. This is useful when the component is less 
granular and its operations may be considered as separate use cases for 
quality assurance.

When you expand an operation, you can see the status of the tests 
associated with the operation. In this context, association indicates that: 

➤ the test is linked to a requirement which is linked to this component

➤ the test script uses this operation.

Requirement Status Description

Failed At least one test associated with the requirement 
has failed.

N/A The terms Passed and Failed do not apply to the 
requirement.

No Run All tests associated with the requirement have a No 
Run status.

Not Completed All tests associated with the requirement have the 
Not Completed status. 

Not Covered There are no tests associated with the requirement.

Passed All test associated with the requirement have 
passed.
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The following table lists the possible statuses:

Tests Coverage

Tests describe the test objective and an implementation of the testing 
objective. They include the test operations and the expected outcome of 
each test. You can generate tests and link them to your components, or you 
can create a set of tests that are automatically linked to components 
through requirements (see Chapter 6, "Generating Requirements and Tests").

When linking directly to tests, you link tests to a component in the Tests 
section of the Testing Status tab. Alternatively, you can link components to 
tests in the Test Plan module. 

Note: You can create coverage between test instances and components using 
the ALLOW_REQ_COVERAGE_BY_TEST_INSTANCE parameter in Site 
Administration. For details about this parameter, refer to the 
HP Quality Center Administrator’s Guide.

The Testing Status > Tests tab lets you see the coverage of the Tests that were 
linked to the component. This information is dynamic and displays the 
current status in percentages.

Status Description

Failed One or more of the tests associated with this operation 
has failed.

No Run All tests associated with the operation have a No Run 
status.

Not Completed All tests associated with the operation have the Not 
Completed status.

Not Covered There are no tests associated with the operation.

Passed All test associated with the operation have passed.
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Defects Coverage

The Testing Status section Defects tab lets you see the coverage of the 
defects that were linked to the component. This information is dynamic and 
is displayed in a chart form, based on the severity of the defects.

You do not link a defect directly to a component. Instead, you link a defect 
to a requirement or test. If the component was assigned a test that is linked 
to a defect, Service Test Management displays the defect status in this tab. 

For details, see the Test Plan module documentation in the Quality Center 
User Guide.

Tasks

How to Check the Testing Status

This following steps describe how to check the testing status of your 
component. You check the testing status by viewing the coverage of the 
aspects, requirements, tests, operations, and defects associated with your 
component.

This task includes the following steps:

➤ "View the Aspects coverage - optional" on page 110

➤ "View the Requirements coverage - optional" on page 110

➤ "View the Operations coverage - optional" on page 110

➤ "View the Tests coverage - optional" on page 111

➤ "View the Rule Violations - optional" on page 111

➤ "View the Defects coverage - optional" on page 112

To check the testing status, you do not need to check all of the coverage 
types. The coverages you need to check depends on how you designed your 
test plan and your area of focus. In one instance you may be interested 
solely in the testing aspects, while in another scenario, the test requirements 
may be the most relevant.
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View the Aspects coverage - optional

 1 Select a component, group, or folder in the tree hierarchy.

 2 Select the Testing Status tab and click its Aspects button. Service Test 
Management shows a graphic representation of the coverage in the top 
pane, and a list of the required aspects in the bottom pane. The graph 
only shows the aspect coverage—not the requirements.

 3 Expand an aspect to see its associated requirements. Click on a 
requirement to open the item in the Requirements module. For details, 
see the HP Quality Center User Guide.

For user interface details, see the "Aspects Tab" on page 115.

View the Requirements coverage - optional

 1 Select a component, group, or folder and click the Testing Status > 
Requirements tab. 

 2 Expand a requirement to see its associated tests. Click on a test to open it 
in the Test Lab module. In the expanded grid, you can drag a test from 
one parent requirement to another.

 3 If there are no requirements associated with this component, use the 
"Generate Requirements and Tests Wizard" on page 97 to create them. To 
add existing requirements to the coverage, click Select Entities to open 
the Requirements tree, and drag an item into the Requirements Coverage 
grid. 

 4 Double-click on a requirement in the grid to open it in the Requirements 
module. To return to your last view, click on the Application Components 
module in the left pane. 

For details about the Requirements tab, see "Requirements Tab" on 
page 116.

View the Operations coverage - optional

 1 Select a component and click the Testing Status > Operations tab. 

 2 Expand an operation to see the status of the tests associated with the 
operation.
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 3 To view the test details, click on a test in the grid to open it in the Test 
Plan module. For details about the Requirements and Test Plan modules, 
see the HP Quality Center User Guide.

 4 To return to your last view, click the Application Components module 
button in the left pane.

For UI details about the Operations tab, see the "Operations tab" on 
page 118.

View the Tests coverage - optional

 1 Select a component, group, or folder and click the Testing Status > Tests 
tab. 

 2 To add more tests for a component, click Select Entities. Expand the tree 
in the Test Plan tab in the right pane and select the test you want to add 
to the coverage. Use the filter button to show only the desired tests. Drag 
the test to the Test Coverage grid, or click the Add to Coverage button.

 3 Click on a test to view the test in the Test Plan module. To return to your 
last view, click the Application Components module button.

Tip: In the grid, use the right-click menu to create new tests or navigate to 
an existing test.

For information about the Tests tab, see the "Tests Tab" on page 119.

View the Rule Violations - optional

 1 Select a component in the Application Components tree.

 2 Select the Testing Status tab and click the Rules tab. Service Test 
Management shows a list of the rule violations for the selected 
component.

 3 To resolve the violations, click Resolve All to open the "Generate 
Requirements and Tests Wizard". For details see page 97.

For user interface details, see the "Rules Tab" on page 114.
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View the Defects coverage - optional

 1 Select a component or group in the tree hierarchy.

 2 Select the Testing Status tab and click the Defects tab. Service Test 
Management shows a graphic representation of the coverage in the top 
pane, and a list of the defects in the bottom pane.

 3 Click on a defect to view its details in the Defects module. To return to 
your last view, click the Application Components module in the left pane.

 4 To refresh the chart, click the Refresh button.

For user interface details, see the "Defects Tab" on page 120.

For more information about the Requirements, Test Plan, and Defects 
modules, see the HP Quality Center User Guide.

Reference

Testing Status Tab

This section describes the interface of the Testing Status sub tabs.

➤ "Testing Status Dashboard" on page 113

➤ "Rules Tab" on page 114

➤ "Aspects Tab" on page 115

➤ "Requirements Tab" on page 116

➤ "Operations tab" on page 118

➤ "Tests Tab" on page 119

➤ "Defects Tab" on page 120
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Testing Status Dashboard 

The Coverage dashboard displays a summary of each of the coverage items: 
Aspects, Requirements, Operations, Tests, and Defects.

The graphs are described below. Click on a graph to open it in its own tab.

To access Application Components module > <select an entity> 
>Testing Status tab > Dashboard

Important 
information

Click on a graph to open it in a separate tab.

Relevant tasks "How to Check the Testing Status" on page 109

UI Elements (A-Z) Description

Aspects A graphical representation of the coverage by the testing 
aspects.

Operations A graphical representation of the coverage by the 
component’s operations. 

Requirements A graphical representation of the status of the 
requirements associated with the component.

Tests A graphical representation of the status of the tests 
associated with the component.

Defects A graphical representation of the coverage for the defects 
associated with the component.
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Rules Tab

This tab enables you to view and manage the rules violated by the selected 
component. 

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

To access Application Components module > <select an entity> 
>Testing Status tab > Rules

Important 
information

See "Rule Violations" on page 104

Relevant tasks "View the Rule Violations - optional" on page 111

UI Elements Description

Select Columns. Enables you to select the columns to 
display in the Rule Violations grid.

Refresh. Reloads the list of rule violations.

Set Filter/Sort. Enables you to set a filter for the rule 
violations or sort the changes by a criteria.

Resolve All. Opens the Generate Requirements and Tests 
wizard to resolve the rule violations. For details, see the 
"Generate Requirements and Tests Wizard" on page 97.

<Rule Violations 
grid>

A list of all the rule violations for the selected 
component.

Default: Rule Name and Rule Description.

Available Columns: Alert ID, Alert is Active, and 
Component Name.
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Aspects Tab 

Displays the coverage per testing aspect in both a graphical representation 
and a grid layout. 

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

To access Application Components module > <select an entity> 
Testing Status tab > Aspects

Important 
information

See "Aspect Coverage" on page 105

Relevant tasks "View the Aspects coverage - optional" on page 110

GUI Element (A-Z) Description

Refresh. Reloads the status of the testing aspects and 
refreshes the graph.

Collapse. Shows the aspect only, but not its tests or 
requirements. 

Expand. Shows the tests associated with the aspect.

<graph pane> A graphical representation of the requirement coverage

<grid pane> A list of all aspects associated with the component.

➤ Expand aspect to see list of associated tests. 

➤ Click test link to go to the test in the Test Lab module.

➤ Click the Application Components module to return 
to the most recent view of the component.
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Requirements Tab

Displays the coverage per testing requirement in both a graphical 
representation and a grid layout.

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

To access Application Components module > <select an entity> 
Testing Status tab > Requirements

Important 
information

See "Requirements Coverage" on page 106

Relevant tasks "View the Requirements coverage - optional" on page 110

GUI Element (A-Z) Description

Select. Opens the Requirements tree enabling you to add 
more requirements to your test. For details see 
"Requirements Tree" on page 117.

Select Columns. Opens the Select Column dialog box 
enabling you to select the columns to display in the grid.

Refresh. Reloads the status of the requirements and 
refreshes the graph.

Remove. Unlinks the requirement and the component. 
Note that unlinking a requirement may remove the 
linkage to all tests and defects that are associated with 
the component only through this requirement.

Collapse. Collapses the graph window and show more of 
the grid.

Expand. Shows the graph window and displays less rows 
of the grid.
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Requirements Tree

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

<graph pane> A graphical representation of the requirement coverage.

<grid pane> A list of all requirements associated with the component.

➤ Expand requirement to see list of associated tests 

➤ Click requirement link to go to the requirement in the 
Requirements module.

➤ Click test link to go to the test in the Test Lab module.

➤ Click the Application Components module to return 
to the most recent view of the component.

GUI Element (A-Z) Description

Add Coverage. Adds coverage for the selected 
requirement. If you select a parent requirement, it adds 
all sub-requirements.

Refresh. Refreshes the Requirements tree.

Set/Clear Filter. Sets or clears the filter.

➤ Set Filter / Sort. Opens the Set Filter/Sort dialog box 
allowing you to filter out and sort the requirements by 
any field.

➤ Clear Filter / Sort. Clears all filters and sorting settings 
and displays all requirements. 

Closes the Requirements tree pane.

To reopen this view, click the Select button in the 
Requirements tab.

<Requirements tree> A tree view of all of the requirements by folder and 
group. An icon indicates the requirement type.

Tip: If a filter is active, there could be hidden 
requirements. To see all requirements, click Clear Filter.

GUI Element (A-Z) Description
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Operations tab 

Displays the coverage per operation in both a graphical representation and a 
grid layout. 

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

To access Application Components module > <select an entity> 
Testing Status tab > Operations

Important 
information

See "Operations Coverage" on page 107

Relevant tasks "View the Operations coverage - optional" on page 110

GUI Element (A-Z) Description

Refresh. Reloads the status of the operations and 
refreshes the graph.

Collapse. Shows the operation name only, but not its 
tests. If there are multiple ports, collapsing the node 
shows the port name, while hiding the operations.

Expand. Shows the operations and their testing status.

<graph pane> A graphical representation of the Operations coverage.

<grid pane> A list of all operations associated with the component.

➤ Expand operation to see list of associated tests. 

➤ Click test link to go to the test in the Test Lab module.

➤ Click the Application Components module to return 
to the most recent view of the component.
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Tests Tab

Displays the status per test in both a graphical representation and a grid 
layout.

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

To access Application Components module > <select an entity> 
Testing Status tab > Tests

Important 
information

See "Tests Coverage" on page 108

Relevant tasks "View the Tests coverage - optional" on page 111

GUI Element (A-Z) Description

Select. Opens the Tests tree enabling you to associate 
more tests with your component. For details see "Tests 
Tree" on page 120.

Select Columns. Opens the Select Column dialog box 
enabling you to select which columns to show in the 
grid.

Refresh. Reloads the status of the test and refreshes the 
graph.

Remove. Unlinks the test from the requirement through 
which it is associated with the component.

Collapse. Collapses the graph window and shows more of 
the grid.

Expand. shows the graph window and displays less rows 
of the grid

<graph pane> A graphical representation of the test coverage.

<grid pane> A list of all tests associated with the component.

➤ Click test link to go to the test in the Test Lab module

➤ Click the Application Components to return to the 
most recent view of the component.
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Tests Tree

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Defects Tab

Displays the status of the defects in both a graphical representation and a 
grid layout.

GUI Element (A-Z) Description

Add Coverage. Adds the selected test to the coverage of 
the component or requirement. If you select a folder or 
group, it adds all sub tests.

Refresh. Refreshes the Tests tree.

Set/Clear Filter. Sets or clears the filter.

➤ Set Filter / Sort. Opens the Set Filter/Sort dialog box 
allowing you to filter out and sort the tests.

➤ Clear Filter / Sort. clears all filters and sorting settings 
and displays all tests. 

Closes the Tests tree pane.

To reopen this view, click the Select button in the Tests 
tab.

<Requirements Tree> A tree view of all of the tests by folder and group

Tip: If a filter is active, there could be hidden tests. To see 
all tests, click Clear Filter.

To access Application Components module > <select an entity> 
Testing Status tab > Defects

Important 
information

See "Defects Coverage" on page 109

Relevant tasks "View the Defects coverage - optional" on page 112
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Select Columns. Opens the Select Column dialog box 
enabling you to select which columns to show in the 
grid.

Refresh. Reloads the status of the defects and refresh the 
graph.

Collapse. Collapses the graph window and show more of 
the grid.

Expand. Shows the graph window and displays less rows 
of the grid.

<graph pane> A graphical representation of the defects coverage.

<grid pane> A list of all defects associated with the component and 
their status.

➤ Click Defect ID link to open the defect in the Defects 
module.

➤ Click the Application Components module to return 
to the most recent view of the defects coverage.

➤ Drag a column separator to adjust its width.
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Linking Components and Requirements

This chapter includes:

Concepts

➤ Linking Components Overview on page 123

Tasks

➤ How to Link Components to Requirements and Tests on page 124

Reference

➤ Linking Component User Interface on page 125

Concepts

Linking Components Overview 

To test components in Service Test Management, you must link them to 
requirements or tests. Requirement coverage is used to connect components 
to other Quality Center entities such as tests, test sets, and defects.

Linking components to requirements and tests helps you keep track of the 
relationship between your requirements and components, and ensures 
compliance with your requirements throughout the testing process. 

For information on viewing test and requirement coverage, see Chapter 7, 
"Determining Test Coverage."

When working in the Requirements module, you can view the components 
linked to each requirements. The Components tab displays a list of those 
components, with other basic information. 
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Using the Test Lab module’s Component tab (available only after you install 
the Service Test Management extension), you can set and view the 
components linked to each test. 

When you link a component to a test, Service Test Management prompts 
you to select a requirement. To allow you to track your testing through 
Quality Center, you link tests to the default requirement or to an existing 
one. 

Tasks

How to Link Components to Requirements and Tests

This task describes how to link components to either requirement or tests. If 
you are linking to a test, you also indicate the requirement to associate with 
the test.

This task includes the following steps:

➤ "Link a component to a requirement - optional" on page 124

➤ "Link a component to a test - optional" on page 124

➤ "Results" on page 125

Link a component to a requirement - optional

Use the Application Components tab in the Requirements module to link 
components to requirements. For details, see "Application Components Tab 
- Requirements Module" on page 127.

Link a component to a test - optional

Use the Application Components tab in the Test Plan module to link a 
component to a test. For details, see "Application Components Tab - Test 
Plan Module" on page 130.
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When you add a test to component coverage, the Link <test-name> to 
Requirement dialog box opens and prompts you to choose the Default 
Requirement or Linked Requirements. Select a requirement and click OK. 
For details, see the "Link <test-name> to Requirement Dialog Box" on 
page 126.

You can also link a component to a test through the Testing Status tab. For 
details, see "Tests Coverage" on page 108.

Results

You can view and modify the linkages in the Application Components tab 
within the Test Plan or Requirements modules. For details, see "Linking 
Component User Interface" on page 125.

Reference

Linking Component User Interface 

This section includes (in alphabetical order):

 ➤ Link <test-name> to Requirement Dialog Box on page 126

 ➤ Application Components Tab - Requirements Module on page 127

 ➤ Application Components Tab - Test Plan Module on page 130
125



Chapter 8 • Linking Components and Requirements
Link <test-name> to Requirement Dialog Box

This dialog box enables you to select a requirement to associate with your 
test.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access Open the Test Plan module, and click the Application 
Components tab.

Click and choose a entity from the 
Application Components tree. 

Click the  button.

Relevant tasks "Link a component to a test - optional" on page 124

See also "General Tab" on page 141 (Customization)

UI Elements (A-Z) Description

Select Columns. Opens the Select Column dialog box 
enabling you to select the columns to display in the grid.

Refresh. Reloads the components in the grid.
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Application Components Tab - Requirements Module 

This tab enables you to link components to an existing requirement.

<Linked 
Requirements grid>

A list of the requirements associated with the test.

To modify the columns, click the Select Columns button.

Link <test-name> to Sets a brokerage requirement option for linking to the 
test. 

➤ Default Requirement. Creates a link between the 
default requirement of the component and the test, if 
it does not already exist. The linked requirements grid 
is not available for this option.

➤ Linked Requirement. Enables you to specify a 
requirement to link to the test. Select a requirement 
from the Linked Requirements grid. This option is not 
available if the component or group has no linked 
requirements. To link a requirement with a 
component, see "View the Requirements coverage - 
optional" on page 110.

To access ➤ Open the Requirements module.

➤ Select View > Requirement Details. 

➤ Expand the tree and select a requirement.

➤ In the right pane, scroll right to Application 
Components tab.

Relevant tasks "How to Link Components to Requirements and Tests" 
on page 124

See also "How to Check the Testing Status" on page 109

UI Elements (A-Z) Description
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

Opens the Application Components tree in the right 
pane to link a component to the requirement. For details, 
see the "Components Tree (Requirements Grid)" on 
page 129.

Delete. Unlinks the component and requirement.

Select Columns. Opens the Select Column dialog box 
enabling you to select the columns to display in the grid.

Refresh. Reloads the components in the grid.

<Linked Components 
Grid>

A list of the components linked to the selected 
requirement. The displayed columns differ per 
component type. For Web Services, they are:

➤ Component folder path. The application component 
path in the tree hierarchy.

➤ Component name. The name of the application 
component.

➤ Import type. For Web Services, the import type: File, 
URL, UDDI, Systinet

➤ WSDL native name. The Web service name as defined 
in the WSDL.

➤ Assigned to QA. QA engineer responsible for 
validating the requirement.

➤ Last updated. The date the component was last 
updated from its original source.

To change the columns displayed, click the  button.
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Components Tree (Requirements Grid)

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

UI Elements (A-Z) Description

Add Component. Adds the selected entity to the Linked 
Components grid.

Refresh. Refreshes the Components tree.

Set/Clear Filter. Opens a dropdown list with the 
following options:

➤ Set Filter / Sort. Opens the Set Filter/Sort dialog box 
allowing you to filter and sort the components

➤ Clear Filter / Sort. Clears all filters and sorting settings 
and displays all components and groups. 

Find. Searches for a component whose name matches the 
text in the search box.

Exit. Closes the Application Components tree pane

To reopen this view, click the Select button.

<component tree> A tree view of all of the component by folder and group. 

Tip: If a filter is active, there could be hidden 
components. To see all components, click Clear Filter.
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Application Components Tab - Test Plan Module 

This tab enables you to link components to an existing test.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access Open the Test Plan Module.

Select View > Test Plan Tree. 

Expand tree and select a test in the left pane.

In the right pane, scroll right to the Application 
Components tab.

Relevant tasks "How to Link Components to Requirements and Tests" 
on page 124

See also "How to Check the Testing Status" on page 109

UI Elements (A-Z) Description

Opens the Application Components tree in the right 
pane to enable linking a component to the test. For 
information about the Components tree, see 
"Component Tree (Tests Grid)" on page 131.

Delete. Unlinks the test from all requirements that 
associate it with the component. 

Select Columns. Opens the Select Column dialog box 
enabling you to select the columns to display in the grid.
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Component Tree (Tests Grid)

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Refresh. Reloads the list in the grid.

<linked components 
grid>

A list of components linked to the test. The displayed 
columns may differ based on the component type. 

➤ Component folder path. The path in the tree 
hierarchy.

➤ Component name. The name of the application 
component.

➤ Import type. The import type: File, URL, UDDI, 
Systinet (Web Services only).

➤ WSDL native name. The service name as defined in the 
WSDL (Web Services only).

➤ Assigned to QA. QA engineer responsible for 
validating the test.

➤ Last updated. The date the component was last 
updated from its original source.

To change the columns displayed, click the  button.

UI Elements (A-Z) Description

Add Component. Adds the selected component to the 
Linked Components grid.

Refresh. Refreshes the Application Components tree in 
the right pane.

Set/Clear Filter. Opens a dropdown list with the 
following options:

➤ Set Filter / Sort. Opens the Set Filter/Sort dialog box 
allowing you to filter and sort the components.

➤ Clear Filter / Sort. Clears all filters and sorting settings 
and displays all components and groups. 

UI Elements (A-Z) Description
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Find. Searches for a component whose name matches the 
text in the search box.

Exit. Closes the Application Components tree pane.

To reopen this view, click the Select button.

<Application 
Components tree>

A tree view of all of the application components by folder 
and group (only visible when you click Select).

Tip: If a filter is active, there could be hidden 
components. To see all components, click Clear Filter. 

UI Elements (A-Z) Description
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Customizing Service Test Management

This chapter includes:

Concepts

➤ Customization Overview on page 133

Tasks

➤ How to Customize a Project on page 138

Reference

➤ Project Customization User Interface on page 140

Concepts

Customization Overview 

You can customize general project data in the Application Components 
module. This includes specifying default values for components stored in 
secure locations and on a proxy server, the default Systinet and UDDI server 
information, the toolkit parsing order for importing component definitions, 
the default requirement folder, and user-defined testing aspects.

You can also customize component and group entities in the same way as 
you can customize other entities in your Quality Center projects. You can 
restrict which user groups can add, delete and modify folders, components, 
and groups. You can determine whether user groups can update 
components and groups, and link components and groups to requirements. 
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In addition, you can customize access to the Application Components 
module for each user group, and customize the system fields and add new 
user-defined fields.

Note: This chapter describes the additional customization options available 
with Service Test Management. For details on Project Customization, refer to 
the HP Quality Center Administrator’s Guide.

This section also includes:

➤ "Testing Aspects" on page 135

➤ "Rules" on page 136

➤ "Service Test Management Permissions" on page 137

➤ "Application Components Module Access" on page 137

➤ "Custom Project Entities" on page 137
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Testing Aspects
You can customize the template for the system and user-defined testing 
aspects displayed in the Requirement and Test Generation wizard. Using the 
Aspects tab, you can add new aspects, modify the properties of system and 
user-defined aspects, and delete user-defined aspects.

In the Aspects tree hierarchy, the  icon indicates a system-defined aspect. 
The  icon indicates a user-defined aspect.

For information on defining aspects, see "Customize the aspects - optional" 
on page 139.
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Rules
Rules let you define the testing aspects to which your component must 
comply. They help you make sure your testing standards are satisfactory and 
that the aspects relevant to the component are covered.

You define a rule through filters and aspects:

➤ Filters. Filters indicate the components to which the rule will be applied. For 
example, if you indicate a filter: Assigned To=john_qa, any component not 
assigned to john_qa, will not be bound by the rule. You can set a rule for a 
component based on a variety of filters. You can use the conditional and 
logical operators that are used in all Quality Center filters. For details, see 
the HP Quality Center User’s Guide.

➤ Aspects. The testing aspects that meet the filter criteria, that must be 
covered for the application component. 

If your application component was not covered by the required aspects, 
Service Test Management creates an Alert. The Testing Status > Rules tab 
lists the violations, and lets you resolve the problems. For details about 
defining rules, see "Customize the component rules - optional" on page 139.
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Service Test Management Permissions 
You can customize the permission settings for user groups relating to their 
access to components, linkage to requirements, and ability to make changes. 
Built-in user group permissions are read-only, but you can create your own 
groups with custom permissions. For details about setting permissions, see 
"Customize group permissions - optional" on page 140.

For more information about user group permissions, refer to the 
HP Quality Center Administrator’s Guide.

Application Components Module Access
After you enable the HP Service Test Management extension for a project, 
you can control access to the Application Components module for each user 
group. You can enable access to all Quality Center modules including the 
Application Components module, or to all Quality Center modules 
excluding the Application Components module. 

For details about customizing module access for user groups, refer to the 
HP Quality Center Administrator’s Guide.

Custom Project Entities
You can customize the system fields and create new user-defined fields for 
your project. You can create new fields for your component and indicate 
whether or not a field is mandatory. If you define a field as required, the 
Details tab shows it as mandatory.
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For task details about customizing project entities, see "Customize project 
entities - optional" on page 140 and the HP Quality Center Administrator’s 
Guide. For more information on Quality Center entities and fields, refer to 
the HP Quality Center Database Reference.

Tasks

How to Customize a Project

This task describes how to customize your Quality Center project as it relates 
to components. You can create rules, assign aspects, and set permissions for 
entities related to your application component. You can also create both 
mandatory or optional fields to the Component Details.

All of the customization settings are optional.

This task includes the following steps:

➤ "Open Project Customization" on page 138

➤ "Customize the General setting - optional" on page 139

➤ "Customize the component rules - optional" on page 139

➤ "Customize the aspects - optional" on page 139

➤ "Define new component types - optional" on page 139

➤ "Customize group permissions - optional" on page 140

➤ "Customize application component module access - optional" on 
page 140

➤ "Customize project entities - optional" on page 140

Open Project Customization

➤ Choose Tools > Customize to open the Customization module.

➤ Click the Return button, located in the top right corner, to return to the 
main Quality Center window.
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Customize the General setting - optional

Define the parsing order for toolkits, and the default servers that host the 
WSDL, UDDI registry, or Systinet registry.

Click the Application Components link. Select the General tab. For user 
interface details, see the "General Tab" on page 141.

Customize the component rules - optional

Define a rule that lists the testing aspects to which your components must 
comply, for all components in the project. If the component does not meet 
the requirements of the rule, it issues a rule violation. For details, see "Rule 
Violations" on page 104.

Click the Application Components link. Select the Rules tab. For user 
interface details, see the "Rules Tab" on page 143.

Customize the aspects - optional

Manage the built-in and custom testing aspects. You can edit the properties 
of the built-in aspects or define new ones. 

Click the Application Components link. Select the Aspects tab. For user 
interface details, see the "Aspects Tab" on page 145.

Define new component types - optional

Create new component types in addition to the built-in ones: General, Web 
Services, and JMS.

Click the Application Components link. Select the Component Types tab. 
For user interface details, see the "Component Types Tab" on page 147.
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Customize group permissions - optional

Assign the permissions for the component-related tasks per user group. For a 
list of the component-related tasks that you can configure, see "Groups 
Pane" on page 151. 

Click the Groups link. Select a user-defined group (not a built-in group) and 
click the Change button. Scroll to the right and select the Application 
Components tab. Modify the permissions as required.

Customize application component module access - optional

Indicate which user groups will have access to the Application Components 
module. 

Click the Module Access link. Select a user-defined group (not a built-in 
group) and double-click the Application Components column to enable or 
disable access to the module. 

Customize project entities - optional

Define new fields for the application component, application group, and 
application changes entities. Indicate if providing values is mandatory or 
optional. For details, see the "Project Entities Pane" on page 148.

Reference

Project Customization User Interface

This section includes (in alphabetical order):

 ➤ General Tab on page 141

 ➤ Rules Tab on page 143

 ➤ Aspects Tab on page 145

 ➤ Component Types Tab on page 147

 ➤ Project Entities Pane on page 148
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 ➤ Groups Pane on page 151

 ➤ Module Access Pane on page 154

General Tab 

This tab enables you to customize the settings for importing WSDLs. You 
can enter a default server and credentials, so that you will not need to enter 
the information each time you import a service. 

User interface elements are described below:

To access Tools > Customize and click the Application Components 
link. Select the General tab.

Important 
information

To resume work in the Quality Center modules, click the 
button in the top right corner.

Relevant tasks "Customize the General setting - optional" on page 139

UI Elements Description

Connection Settings ➤ <Description>. Text indicating the connection settings 
for WSDL imports.

➤ . Opens the Connection Setting 
dialog box for setting the default connection settings. 
For details, see "Connection Settings Dialog Box" on 
page 66.

Default Systinet 
Server

Server Name. The default path of the Systinet server 
when a user opens the Select Service from Systinet Dialog 
Box.

Note: Systinet versions 2-3.x are supported.

Default UDDI Server ➤ URL. The default address of the UDDI server when a 
user opens the Select Service from UDDI Dialog Box, 
for example http:/<my_server>.<my_domain>:8090/
juddi/inquiry.

➤ Version. The UDDI version: 2 or 3.
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Select Requirement
This dialog box lets you select a default requirement.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Auto-Detect Toolkit 
Order

Parsing Order. The order in which to try toolkit parsers 
when importing a WSDL in Auto-detect mode.

Default 
Requirements

➤ Location. The default requirement to use when linking 
a component to a test. The Browse button opens 
the Select Requirement dialog box.

➤ Requirement Type. One of the standard requirement 
types: Functional, Testing, or Undefined.

Fuzzy Import ➤ Use fuzzy logic on import. For .NET services, use a 
looser set of criteria for parsing the components.

➤ Number of Attempts. The number of attempts to try 
parsing the WSDL before aborting the import.

UI Elements (A-Z) Description

Refresh. Refreshes the selected requirement.

Set/Clear Filter. Opens a dropdown list with the 
following options:

➤ Set Filter / Sort. Opens the Set Filter/Sort dialog box 
allowing you to filter and sort the requirements.

➤ Refresh All. Refreshes all of the requirements in the 
tree. 

➤ Clear Filter / Sort. Clears all filters and sorting settings 
and displays all requirements. 

Find. Finds the requirement containing the specified text.

<Requirements Tree> Tree hierarchy of all the requirements.

UI Elements Description
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Rules Tab 

This tab lets you define rules for the application components in your 
project. 

User interface elements are described below:

To access Tools > Customize and click the Application Components 
link. Select the Rules tab.

Important 
information

To resume work in the Quality Center modules, click the 
button in the top right corner.

Relevant tasks "Customize the component rules - optional" on page 139

See also "Alerts Dialog Box" on page 28

UI Elements Description

Opens the Create New Rule dialog box.

Removes the selected rules from the Rule list.
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Filter Dialog Box 

User interface elements are described below:

Rules A list of the rules defined for the current project.

Properties The properties of the rule:

➤ Rule. The rule name. If a component violates a rule, 
the Alert box lists it by this name. 

➤ Components. The rule is only applied to components 
that meet the selected conditions. To include all 
components in the project, define a filter to display all 
components with a Component ID > 0. To set a 
condition, click the button to open the 
Filter Dialog Box. 

➤ Aspects. The testing aspects that must be covered for 
the component. To select the aspects, click the 

button to open the Select Aspect dialog 
box.

➤ Description. Text describing the rule. To allow Service 
Test Management to generate a description based on 
the selected aspects and conditions, select Use 
Automatic Text.

UI Element s(A-Z) Description

Clear Filter. Clears all conditions to which the rule 
should apply.

Copy filter. Copies the current filter settings onto the 
clipboard. You can paste this filter for another rule or 
save it to a text file for later use.

Paste filter. Uses a filter from the clipboard.

UI Elements Description
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Aspects Tab 

This tab lets you define the properties of the built-in aspects and define new 
ones for the project.

User interface elements are described below:

Field Name The field names to which you can apply a conditions. 
The field names correspond to the component details in 
the Project Entities list.

Filer Condition The condition that must be met. You can use asterisks (*) 
as wild cards.

To access Tools > Customize and click the Application Components 
link. Select the Aspects tab.

Important 
information

To resume work in the Quality Center modules, click the 
button in the top right corner.

Relevant tasks "Customize the aspects - optional" on page 139

See also "Alerts Dialog Box" on page 28

UI Elements Description

Opens the Create New Aspect dialog box.

Removes the selected aspect from the list. You can only 
delete user-defined aspects—not built-in ones.

UI Element s(A-Z) Description
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Aspects A list of the aspects that are available for the current 
project.

Properties The properties of the rule:

➤ Aspect Name. The aspect name as it will appear in the 
tree. For built-in aspects this field is read-only. 

➤ Aspect Description. Text describing the goal of the 
aspect.

➤ Requirement type. The requirement type: Undefined, 
Business, Group, Functional, or Testing. If you plan to 
link tests to this requirement, for example, by 
generating requirements and tests at the same time, 
use the Covering type. For details, see the Quality 
Center User Guide.

➤ Requirement name. A name for the requirement. To 
include the component name, use the variable 
%service_name%.

➤ Description. Text describing the requirement. To 
include the component name, use the variable 
%service_name%.

UI Elements Description
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Component Types Tab

This pane provides information for the different application component 
types. You can control which fields will be available in the Details and 
Interaction tabs for each component type and if they are mandatory.

To access Tools > Customize and click the Application Components 
link. Click the Component Types tab.

Relevant tasks "Define new component types - optional" on page 139 

UI Elements (A-Z) Description

Adds a new component type to the list. To rename the 
component, enter text in the right pane’s Name field.

Removes the selected component from the list (except for 
General and Web Services types).

Note: You cannot remove a type if a component of that 
type exists in the repository. 

Opens the Choose Image for Application Component 
Type dialog box, enabling you to choose an icon to 
represent the type.

Component types A list of the built-in and custom component types. The 
built-in types are General, Web Service, and JMS.
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Project Entities Pane

This pane lists the project entities. Each entity contains system fields and 
user-defined fields: 

➤ System fields. These are Quality Center default fields. You cannot add or 
delete system fields—you can only modify them.

Details The component details:

➤ Name. The name of the component as it will appear in 
Quality Center.

➤ Assigned Icon. The icon representing the component 
in the Application Components tree. For details, see 
"Application Components Module Icons" on page 47.

➤ Replace opens a dialog box for changing the icon.

➤ Support file extensions. The file extensions supported 
as a contract for components of this type, for example, 
WSDL 

➤ Contract parser. The COM object of the parser GUID 
used for parsing a component definition file, such as 
the WSDL.

Fields The fields that will be available in the component’s 
Details and Interaction tabs. These settings are specific 
for each component type—both built-in and 
user-defined.

➤ Included in Type. Show the field in the components’s 
Details tab, but do not make it mandatory.

➤ Required for Type. Show the field in the components’s 
Details tab, and make it mandatory.

➤ Interaction Field. Show the field in the Interaction 
section of the Add New Component dialog box and 
Interaction tab.

For details, see the "New Application Component Dialog 
Box" on page 43.

UI Elements (A-Z) Description
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➤ User fields. Customizable user-defined fields. You can add, modify, and 
delete user-defined fields. 

For detailed information on Quality Center entities and fields, refer to the 
HP Quality Center Database Reference. 

User interface elements are described below and in greater detail in the HP 
Quality Center User Guide.

To access Tools > Customize and click the Project Entities link. 
Expand the Application Component, Application 
Component Group, or Application Component Change 
entities.

Important 
information

You can only create and delete User fields, but not 
System fields.

Relevant tasks "Customize project entities - optional" on page 140

See also  "Application Component Details Pane" on page 39

UI Elements (A-Z) Description

Opens a dropdown list allowing you select to a New Field 
or a New Memo Field.

Removes the selected User field.

Allow Multiple Values For user-defined fields, this option allows the user to 
select more than one value in any field that is associated 
with a predefined lookup list. (Available only when the 
Lookup List type is selected.) 

Field Label The name of the field to display in the Project Entities 
tree and the component’s Details tab.

Field Length The field size. (Available for String type only.) 

Note: The maximum field length is 255 characters. 

Field Name The field name used in the Quality Center database table. 
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Field Type The type of data valid for the field: 

➤ Number. Enables integer entry only.

➤ String. Enables the entry of any character string.

➤ Date. Enables the selection of a date.

➤ Lookup List. Displays the Lookup List area and 
enables the selection from a drop-down list. 

➤ User List. Enables the selection of a user name from 
your Quality Center users list.

➤ Memo. Enables the entry of blocks of data. Note 
that you can add up to 5 memo fields to each 
Quality Center entity.

Goto List Displays a predefined list. (Available only when the 
Lookup List type is selected.) To open a predefined list, 
select a list from the Lookup List box and click the Goto 
List button. 

History Preserves a log of values entered in the selected field. 

Lookup List A list of predefined lists. (Available only when the 
Lookup List type is selected.) To associate a field with a 
predefined list, select a list from the Lookup List box. To 
view or modify the selected list, click the Goto List 
button. 

Masked The input data mask for the field. (Available only when 
the String type is selected.) 

New List Creates a new list. (Available only when the Lookup List 
type is selected.) To associate a field with a new list, click 
the New List button. The Project Lists dialog box opens. 

Required Indicates that a user must enter a value for the field. 

Note: If you set a field as required in a project that 
already contains data, users do not need to enter a value 
for the field when they modify an existing record if the 
field is already empty. 

UI Elements (A-Z) Description
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Groups Pane

This tab lets you define new user groups and set their permissions. 

Searchable Indicates a searchable field. (Available only when the 
Text Search option is enabled in the DB Servers tab. 

Verify List Limits the user to select a value only from the items that 
are listed in the list box. (Available when Lookup List or 
User List is selected.) 

To access Tools > Customize and click the Groups link. Select a 
group. 

To view only: Click View in the Permissions section.

To modify: Click Change. This is only available for 
user-defined groups.

Select the Application Components tab (you may need to 
scroll to the right). 

Important 
information

To resume work in the Quality Center modules, click the 
button in the top right corner.

Relevant tasks "Customize group permissions - optional" on page 140

See also "Customize application component module access - 
optional" on page 140

UI Elements (A-Z) Description
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The Application Components tab displays the following tasks that are 
available in the Application Components module:

Task Description

Add Component User group can add components to the Application 
Components module. 

Modify Component User group can modify components in the 
Application Components module. Note that this 
task enables you to specify the fields that the 
selected user group can modify.

Tip: Expand this task to set permissions for specific 
fields within the tab.

Delete Component User group can delete components from the 
Application Components module. 

Link Component to 
Requirements

User group can link components to requirements in 
the Application Components module. 

Update Component/Group User group can update components or groups. Note 
that selecting this task automatically enables the 
Modify Component task. 

Add Component Folder User group can add folders to the Application 
Components tree. 

Modify Component Folder User group can modify folders in the Application 
Components tree. This task enables you to specify 
the fields that the selected user group can modify. 

Tip: Expand this task to set permissions for specific 
fields within the tab.

Delete Component Folder User group can delete folders from the Application 
Components tree.

Add Group User group can add groups to the Application 
Components module. 
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Modify Group User group can modify groups in the Application 
Components module. This task enables you to 
specify the fields that the selected user group can 
modify.

Tip: Expand this task to set permissions for specific 
fields within the tab.

Delete Group User group can delete groups from the Application 
Components module. 

Link Group to Requirements User group can link a group to a specific 
requirement.

Emulate Component User group can emulate Web Service components 
from Quality Center.

Add Change User group can add changes to the Application 
Components module.

Modify Change User group can modify changes in the Application 
Components module. This task lets you specify the 
fields that the selected user group can modify.

Tip: Expand this task to set permissions for specific 
fields within the tab.

Delete Change User group can delete changes from the Application 
Components module.

Customize Application 
Components

User group can specify settings for the Application 
Components module, using the Application 
Components link in Project Customization.

Link Component to 
Component

User group can link one component to another.

Link Component to Group User group can link a specific component to a 
group.

Task Description
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Module Access Pane

This pane lists the module access per group. You can control access for the 
following modules: Defects, Test Plan, Test Lab, Requirements, Business 
Components, Management, and the Application Components modules.

For detailed information on module access, refer to the HP Quality Center 
Database Reference. 

User interface elements are described below and in greater detail in the HP 
Quality Center User Guide.

To access Tools > Customize and click the Module Access link. 

Relevant tasks "Customize application component module access - 
optional" on page 140 

See also "Customize group permissions - optional" on page 140

UI Elements (A-Z) Description

Enables the selected group to access any of the Quality 
Center modules.

Disables the selected group from accessing any of the 
Quality Center modules.

<module access grid> A table indicating each group’s permission per module. 
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Change Analysis

This chapter includes:

Concepts

➤ Change Analysis Overview on page 155

Tasks

➤ How to Perform Change Analysis on page 158

Reference

➤ Changes Tab on page 161

Concepts

Change Analysis Overview 

Change impact analysis helps you assess the impact of changes to the 
application components. For each change, Service Test Management 
displays a description of the change, an assessment of the change-risk, and 
the change status.

You can introduce changes manually and specify the change details. If you 
know of changes in the component’s contract, you manually insert a new 
change and provide details about the change and its risk.

Service Test Management also generate a change list automatically. When 
you update an application component or a application group, it compares 
the latest definition with the definition stored in Quality Center. If there are 
changes at the operation signature level or in the data structure of an 
argument, Service Test Management lists them in the Changes tab.
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In addition to the above methods, developers can register changes through a 
IDE plug-in.

Service Test Management flags changed application components, groups, or 
folders, in the Components tree with an Alert icon. 

Tip: A green asterisk on the Changes tab indicates a new change.

To verify the changes, you can generate a test set. These test sets can contain 
all tests linked to the updated component, or only tests that use the 
operations affected by the changes. 

Each test set must be linked to a requirement. If a component does not have 
requirement coverage, Service Test Management lets you link it to a default 
requirement.

After creating or generating change-based requirements and a test set, you 
can run the linked or affected tests in the test set to verify whether these 
changes caused regression in functionality or performance. You can then 
determine which entities were effected and who is responsible for them.

To determine if a change violates a rule associated with a component, see 
the "Rules Tab" on page 114.

Reporting Changes Manually
Service Test Management allows you to define changes manually. This 
change can indicate an update in the contract file.

Using the Change Details dialog box, you must indicate the following items:

➤ Subject. A text box with a meaningful name for the change.

➤ Affected part. The name of the affected application component part or 
application group.

➤ Change Status. In Test, New, Obsolete, or Modified

➤ Risk. High, Medium, or Low

➤ Affected part type. Component, Field, Interface, or Operation
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➤ Change type. Added, Updated, or Removed

You can also add descriptions and comments, and assign the change to 
developers or QA personnel. For details, see "New Change Dialog Box" on 
page 163.

Reporting Changes by Updating Components
You can use the Update Component feature to check for changes in a 
component. If changes are found, the component’s definition stored in 
Quality Center is updated. You can update the definition from the original 
location or from a custom location. 

For Web Service components, you must use the original location type: File, 
URL, UDDI, or Systinet. You can update WSDLs that reside on secure 
locations and WSDLs accessed through proxy servers using the 
authentication credentials. For details, see the "Secure Services and Proxy 
Servers" on page 57.

Note: When updating a Web service from a UDDI or Systinet server, it must 
have the same name as the one in the original WSDL used to import the 
service.

You can update individual components through the Components menu. 
When you update a component, the Changes tab lists the changes. Service 
Test Management flags the application component with an Alert icon, in 
the Component tree. For details, see "Review the changes" on page 160.

Note: If Keep up to date is set to Yes in the Details tab, the component 
definition is automatically updated from the original source each time it is 
loaded.
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Tasks

How to Perform Change Analysis

This task describes how to create and review the changes for your 
application component. 

This task includes the following steps:

➤ "Define a New Change - optional" on page 158

➤ "Update a Component - optional" on page 159

➤ "Review the changes" on page 160

➤ "Evaluate the tests" on page 160

➤ "Create regression tests" on page 160

➤ "Run the test sets" on page 160

➤ "Check the test status" on page 160

➤ "Update the change status" on page 161

 1 Define a New Change - optional

To manually define a change in the Changes list:

 a In the Application Components tree, select the component you want 
to update. 

 b Choose the Changes tab and click the New Change button.

 c Fill in the following mandatory fields: 

➤ Subject. A text box with a meaningful name for the change.

➤ Affected part. The name of the affected application component 
part.

➤ Change Status. In Test, New, Obsolete, or Modified

➤ Risk. High, Medium, or Low

➤ Affected part type. Component, Field, Interface, or Operation

➤ Change type. Added, Updated, or Removed
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 d Enter values into the optional fields, such as Description, Assigned 
to…, and so forth.

 2 Update a Component - optional

To instruct Service Test Management to automatically generate a list of 
changes, update the component contract stored in Quality Center with the 
latest contract file. Service Test Management flags the changed component 
in the Components tree.

 a In the Components tree, select the component you want to update. 

 b Choose one of the following update options:

➤ To update a component using the same contract location, choose 
Components > Update Component > Update Component. 

➤ To update a component using a different location, choose 
Component > Update Component > Update Component from. 
Browse for a newer version of the contract in another location.

The update process begins. Service Test Management checks for 
changes in the contract and informs you if the component was 
updated.
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 3 Review the changes

Select an application component that has been updated, indicated by an 
alert icon . Click the Alerts icon to open the Alerts dialog box and view 
a list of the alerts. Click Show to open the Changes tab. The grid lists the 
changes that were made to the component. For details, see the 
"Application Change Details Dialog Box" on page 165.

 4 Evaluate the tests

Evaluate the tests that are associated with the component in the Testing 
Status tab, and add additional tests if necessary. For more information 
about tests linked to components, see "View the Tests coverage - optional" 
on page 111.

 5 Create regression tests

Click Create Test Set to open the wizard that creates tests to analyze the 
impact of change. For details, see the "Create Change Impact Test Set 
Wizard" on page 167

 6 Run the test sets

Run the test sets from the Test Lab module. You can verify the component 
behavior and analyze the test results using Quality Center graphs, reports, 
and documents. For details on running test sets and analyzing test results, 
refer to the HP Quality Center User’s Guide.

 7 Check the test status

Review the coverage status of the parent requirement created for the 
changes set in the Testing Status tab, and verify the changes. For details, 
see “"Requirements Coverage" on page 106.
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 8 Update the change status

Verify the behavior of the changed component and manually update the 
change status in the Changes tab. 

 a Select an updated component in the Components tree, and click the 
Changes tab.

 b In the grid, select the change whose status you want to update.

 c Double-click in the Change Status column, select a change status:

➤ Verified. if the change was tested and did not cause a regression.

➤ Obsolete. if the change does not affect the component.

For details about change status, see the "Application Change Details 
Dialog Box" on page 165.

Reference

Changes Tab

This section includes (in alphabetical order):

 ➤ Changes on page 162

 ➤ New Change Dialog Box on page 163

 ➤ Application Change Details Dialog Box on page 165

 ➤ Create Change Impact Test Set Wizard on page 167
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Changes

This pane enables you to view and manage the changes made to the 
application component. 

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access  Application Components module, <select_entity> 
Changes tab.

Relevant tasks "Review the changes" on page 160

Important 
Information

For folders and groups, the Changes tab is read-only.

UI Elements Description

New Change. Opens the New Application Change dialog 
box to create a new change upon your component. See 
the "New Change Dialog Box" on page 163.

Change Details. Opens the Application Change Details 
for viewing and editing. See the "Application Change 
Details Dialog Box" on page 165

Delete. Removes a change from the Changes grid.

Select Columns. Enables you to select the columns to 
display in the Changes grid. 

For a description of the columns, see the "Application 
Change Details Dialog Box" on page 165.

Refresh. Reloads the list of changes.

Set Filter/Sort. Enables you to set a filter for the changes 
or sort the changes by a criteria.
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New Change Dialog Box

This dialog box lets you define a new change for your component.

User interface elements are described below:

Create Test Set. Opens the Create Change Impact Test Set 
wizard. For details, see "Create Change Impact Test Set 
Wizard" on page 167.

<Changes grid> A list of all the changes for the selected component to 
which the filter applies. To clear the filter, use the Set/
Filter sort button. To arrange the columns, use the Select 
Columns button.

Default: Subject, Affected Part Type, Affected Part, 
Change Type, Risk, Change Status. Creation Date, 
Assigned To, Release, and Cycle.

To access Changes tab > New Change  button.

Relevant tasks "Review the changes" on page 160

See also "Changes" on page 162.

UI Elements (A-Z) Description

Clears all the fields in the dialog box.

Affected part The name of the part affected by the change, such as the 
component name or operation name.

Affected part type The part type affected by the change: Component, 
Interface, Operation, or Field.

Assigned to The user name of the person who is responsible for the 
change.

UI Elements Description
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Change status The current status of the change. By default, the change 
status is New. Update the status throughout the change 
analysis process as follows:

➤ In test. The change is being tested.

➤ New. There is a change in the component.

➤ Obsolete. The change does not affect the component.

➤ Verified. The change was tested and did not cause a 
regression.

Change type The type of change is indicated as follows:

➤ Added. New functionality was added.

➤ Removed. Functionality was removed.

➤ Updated. Changes were made to existing functionality. 
Details of these changes are displayed in the 
Description column.

Created by The user name of the person who created the changes.

Creation date The date on which the change was made. By default, the 
creation date is set to the current database server date.

Creation time The time at which the change was made. 

Default: the current database server time.

Cycle The testing cycle in which the change was introduced or 
in which the change needs to be verified.

Description A description of the change and suggested tests to verify 
them. 

For operation changes (where Part Type is Operation and 
Change Type is Updated), the change description 
contains details of the argument that was added or 
removed from the operation.

UI Elements (A-Z) Description
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Application Change Details Dialog Box

This dialog box enables you to view and manage the changes applied to the 
component. 

User interface elements are described below:

Release The planned release version.

Risk The business risks and costs associated with the change. A 
change can have one of the following risk levels:

➤ High. Changes that are likely to affect functionality 
and fail any test that is not updated. High-risk changes 
include operation removal and parameter changes.

➤ Medium. Changes that may affect functionality, but 
may not necessarily fail existing tests. Medium-risk 
changes include component changes (notification that 
some of the component files have changed).

➤ Low. Changes that are unlikely to fail or affect existing 
functionality or implemented tests. Low-risk changes 
include operation additions (as they do not affect 
existing functionality), service address changes 
(deployment only), and port type changes.

To access Changes tab > Change Details  button.

Relevant tasks "Review the changes" on page 160

See also "Changes" on page 162.

UI Elements(A-Z) Description

Affected part The component part affected by the change.

Affected part type The part affected by the change: Component, Field, 
Interface, or Operation.

Assigned to The user name of the person responsible for the change.

UI Elements (A-Z) Description
165



Chapter 10 • Change Analysis
Change status The current status of the change. By default, the change 
status is New. Update the status throughout the change 
analysis process as follows:

➤ In test. The change is being tested.

➤ New. There is a change in the component.

➤ Obsolete. The change does not affect the component.

➤ Verified. The change was tested and did not cause a 
regression.

Tip: To eliminate the Alert icon next to the component, 
change the status of all changes to Verified or Obsolete.

Change type The type of change is indicated as follows:

➤ Added. New functionality was added.

➤ Removed. Functionality was removed.

➤ Updated. Changes were made to existing functionality. 
Details of these changes are displayed in the 
Description column.

Created by The user name of the person who ran the update that 
created the change.

Creation date The date on which the change was made. By default, the 
creation date is set to the current database server date.

Creation time The time at which the change was made. 

Default: the database server time at the time of the 
change.

Cycle The testing cycle in which the change was introduced or 
in which the change needs to be verified.

Description A description of the change and suggested tests to verify. 

For operation changes (where Affected Part Type is 
Operation and Change Type is Updated), the change 
description contains details of the argument that was 
added or removed from the operation.

UI Elements(A-Z) Description
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Create Change Impact Test Set Wizard

This wizard enables you to create a test set for determining the impact of 
changes made to an application component.

Release The planned release version.

Risk The business risks and costs associated with the change. A 
change can have one of the following risk levels:

➤ High. Changes that are likely to affect functionality 
and fail any test that is not updated. High-risk changes 
include operation removal and parameter changes.

➤ Medium. Changes that may affect functionality, but 
may not necessarily fail existing tests. Medium-risk 
changes include changes (notification that some of the 
component files have changed).

➤ Low. Changes that are unlikely to fail or affect existing 
functionality or implemented tests. Low-risk changes 
include operation additions (as they do not affect 
existing functionality), service address changes 
(deployment only), and port type changes.

To access Changes tab > _.

Relevant tasks "Create regression tests" on page 160

Wizard map The Create Change Impact Test Set wizard contains:

Coverage Page > Test Set Page 

UI Elements(A-Z) Description
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Elements (A-Z) Description

Select Columns. Enables you to select the columns to 
display in the Changes grid.

Refresh. Reloads the list of changes.

Selects all records in the Changes list.

<Changes grid> A list of all the changes for the selected component. To 
set the columns to display, use the Select Columns 
button.

Default: Subject, Affected Part Type, Affected Part, 
Change Type, Risk, Change Status. Creation Date, 
Assigned To, Release, and Cycle.

Scope The scope of the test set:

➤ All tests. Create a test set using all tests linked to the 
component.

➤ Tests affected by the following changes. Create a test 
set only using the tests that were affected by the 
selected change(s). Select the changes you want to 
analyze. Make a multiple selection using the Ctrl key.

Coverage The components to cover with the test set. Either of the 
following options:

➤ <component_name> only 

➤ <component_name> and all Dependent 
Components
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 Test Set Page
This wizard helps you create a test set to determine the impact of your 
changes to the component. The test set will contain all the tests you need to 
run, in order to establish that your change did not affect the functionality of 
the component. 

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Wizard map The Create Change Impact Test Set wizard contains:

Create Change Impact Test Set Wizard > Test Set Page 

UI Elements (A-Z) Description

Select. Opens the Test Plan tree to enable you to select 
tests to include in the test set.

Delete. Removes the selected test from the Tests grid.

Browse. Opens the Select Test Set folder dialog box. 

Tip: In the Select Test Set folder dialog box, click the New 
Folder button  to create a new folder.

Add to Coverage, Adds the selected test to the test grid in 
the left pane.

Note: Only visible from the Test Plan pane.

Refresh. Reloads the list of tests in the Test Plan tree.

Note: Only visible from the Test Plan pane.

Set Filter/Sort. Enables you to set a filter for displaying 
the tests by a criteria.

Note: Only visible from the Test Plan pane.

<Tests grid> A list of all the tests in the test plan. To add tests, click 
the Select button and drag in tests from the Test Plan 
tree.
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Folder The folder name for the test set. Use the Browse button 
to locate a folder.

Name A name for the test plan.

Test Plan list An expandable list of the tests available for the 
component.

Note: Only visible when you click the Select button.

UI Elements (A-Z) Description
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Reports and Graphs

This chapter includes:

Concepts

➤ Service Test Management Reports and Graphs Overview on page 171

Tasks

➤ How to Create and Generate Reports on page 181

➤ How to Generate Graphs on page 183

Concepts

Service Test Management Reports and Graphs Overview

Quality Center’s Dashboard module provides you with several ways to 
generate summary reports.

Using the standard Document Generator, you can create summary reports of 
your test plan and requirements. Use the Tools menu to open the Document 
Generator. For details, see the Quality Center User Guide.

This section describes the Excel reports that you can generate through 
Quality Center, that are specific to Service Test Management.

Using the capabilities of Excel, you can create data tables and display the 
results in graphical form. You can also create custom reports, by designing 
Excel-compatible SQL queries. 
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You can use the data you extract from a query for external applications, such 
as running a Visual Basic script to process and analyze the data.

This section also includes: 

➤ "Built-in Reports" on page 172

➤ "Application Component Query Builder Entities" on page 174

➤ "Application Component Graphs" on page 175

➤ "Application Changes Graphs" on page 178

Built-in Reports 
Service Test Management provides the following pre-defined reports for 
application components:

Report Name Description

Active Changes Exports the project's application components and their 
list of active changes.

Application 
Component Defects

Exports the project's application components and the list 
of new or open defects which are linked to them.

Application 
Component Tests

Exports the project's application components and the list 
of tests which either use or cover them.

Application 
Components Per 
Responsible User

Exports the count of application components per a 
responsible user and displays this data as an Excel chart

Coverage Exports the requirement coverage of each application 
component and the total coverage. The results are 
displayed in a table and in a pie chart.

Outstanding 
Changes

Exports the list of changes in the application 
components which are in the 'New' or 'In Test' status.

Rule Violations Exports the list of all rules together with components 
which violated them.
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You can generate the reports as is, or modify them as necessary in the Query 
Builder. For details, see "Create a custom report based on a pre-defined 
report" on page 181.

Web Service 
Components by 
Toolkit

Exports the distribution of toolkits which are used by the 
Web services.

Web Service 
Components by Type

Exports the distribution of Web service import types: File, 
URL, UDDI, or Systinet.

Report Name Description
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Application Component Query Builder Entities 
You can create custom queries on the project’s database by choosing 
application component related entities from the Entities list. You can add 
these queries to an existing report, or create a new one. 

Service Test Management adds the following entities to Query Builder’s 
Entities View: Component Change to Defects, Component Change to 
Requirements, Component Folder, Component Param, Component Step, 
Component Type, Component Type to Field Relation, Service Aspect, 
Service Dependency, Service Folder, Service Group to Requirement 
Relation, Service Operation to Component Relation, Service Operation to 
Test Relation, Service to Group Relation, Service to Requirement Relation, 
WSDL Operation, WSDL Operation Dependency, and WSDL Operation 
Parameters. You can create both private queries or public ones that you can 
share with other users.

For example, you could create a pivot table to summarize 
component-related data, such as to display in tabular format the status 
count for the different coverage statuses.
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Once you generate an Excel report, you can use the full capabilities of Excel 
to display the results in graphical form, such as bar or pie charts.

For task details, see "How to Generate Graphs" on page 183.

Application Component Graphs
You can create custom graphs for the Application Component module using 
Service Test Management’s built-in graphs. You can create Progress, 
Summary, and Trend graphs for the application components and for the 
application component changes.

The graph’s Configuration tab lets you customize the graphs by setting the x 
and y axis, filtering the data, and grouping the results.

Summary Graphs

In Application Component Summary graphs, you can configure the x-axis 
to display one the following fields: Assigned to Dev, Assigned to QA, 
Authentication default credentials, Created by, Development status, Has 
changed, Import type, JMS provider, JMS transport, JNDI initial context 
factory, Keep up to date, Messaging model, Override address, Proxy default 
credentials, Toolkit, Use authentication, Use proxy, Visibility, QC Project, or 
other fields that you defined in customization.

You can configure the y-axis to display 

➤ A Count of the Application components

➤ A Sum of the custom fields, defined in the Customization module 

Service Test Management also allows you to filter the graph by all system 
and UDF fields defined for the Application Component entity.
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The following Summary graph shows the number of components assigned 
to QA as a function of the total number of components.

Progress Graphs

You can set up a Progress graph to plot the number of application 
components against a time interval.

You can configure the x-axis to display a time interval: Last 7 days, Last 5 
weeks, Last 12 months, or All days.

You can configure the y-axis to display 

➤ A Count of the Application components

➤ A Sum of the custom fields, defined in the Customization module 

You can group the results by the following criteria: Assigned to Dev, 
Assigned to QA, Authentication default credentials, Development status, 
Has changed, Import type, JMS provider, JMS transport, JNDI initial context 
factory, Keep up to date, Messaging model, Override address, Proxy default 
credentials, Toolkit, Use authentication, Use proxy, and Visibility.
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The following Progress graph shows the time interval of the application 
components as a function of the total number of components. The colored 
lines indicate the various types of application components: General, JMS, 
Web Service, and so forth.

Trend Graphs

You can set up a Trend graph to plot the trend of application components 
against a time interval.

You can configure the time period to: Last 7 days, Last 5 weeks, Last 12 
months, or All days.

You can configure the grouping to: All fields, Assigned to Dev, Assigned to 
QA, Authentication default credentials, Development status, Has changed, 
Import type, JMS provider, JMS transport, JNDI initial context factory, Keep 
up to date, Messaging model, Override address, Proxy default credentials, 
Toolkit, Use authentication, Use proxy, and Visibility.
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The following Trend graph shows the different component types as a 
function of their creation dates.

Application Changes Graphs
You can create graphs to plot the application’s changes using Service Test 
Management’s built-in graphs. You can create Progress, Summary, and 
Trend graphs for the application components and for the application 
changes.

Summary Graphs

In Application Changes Summary graphs, you can configure the x-axis to 
display one the following fields: Affected part type, Assigned to, Change 
status, Change type, Created by, Cycle, Release, Risk, and QC Project.

The y-axis display the number of (Count) of the application changes.

You can filter the graph by all of the fields, including all system and UDF 
fields defined for the entity, such as Affected part type, Assigned to, Change 
ID, Change status, Change type, Created by, Creation date, Creation time, 
Cycle, Release, Risk, Subject, or custom fields.
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You can group the results by the following criteria: Affected part, Affected 
part type, Assigned to, Change status, Change type, Created by, Creation 
date, Creation time, Cycle, Release, Risk, or QC Project.

The following Changes Summary graph shows the number of risks, grouped 
by the risk level, as a function of the total number of changes.

Progress Graphs

You can set up a Progress graph to plot the number of application changes 
against a time interval.

You can configure the x-axis to display a time interval: Last 7 days, Last 5 
weeks, Last 12 months, or All days.

The y-axis display the number of (Count) of the application changes.

You can group the results by the following criteria: Assigned to, Change 
status, Cycle, Release, or Risk.
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The following Changes Progress graph shows the time interval of the 
application components as a function of the total number of components. 
The colored lines indicate the various levels of risk: High, Low, and Medium.

Trend Graphs

You can set up a Trend graph to plot the trend of application changes 
against a time interval.

You can configure the time period to: Last 7 days, Last 5 weeks, Last 12 
months, or All days.

You can configure the grouping to: All fields, Assigned to, Change status, 
Cycle, Release, and Risk.
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Tasks

How to Create and Generate Reports

This task describes how to create reports using Quality Center’s built-in 
reports for application components.

This task includes the following steps:

➤ "Generate a pre-defined report" on page 181

➤ "Create a custom report based on a pre-defined report" on page 181

➤ "Create new Excel reports" on page 182

Generate a pre-defined report 

Use the Dashboard module to generate pre-defined Excel reports.

 1 Open the Dashboard module and select the Analysis View tab.

 2 Select a report from the Public/stm-reports folder.

 3 Click Generate. Specify a location for the Excel report.

Create a custom report based on a pre-defined report

You can use an existing report as a basis for creating a custom report.
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 1 Open the Dashboard module and click the Analysis View tab. 

 2 Select a report from the Public/stm-reports folder.

 3 To customize a built-in report without providing access to other users, 
copy it to the Private folder and rename it.

To customize a built-in reports and allow everyone to access your report, 
keep it in the Public folder.

 4 Open the Configuration tab in the right pane, and click the Query Builder 
button.

 5 Select an entity in the right pane’s Entities View and expand it.

 6 Drag the desired parameter to a location within the SQL statement. 
Modify the SQL as required.

 7 Click OK to save it and close the Query Builder.

 8 Click Generate and specify a location for the Excel report.

Create new Excel reports

You can design a new report without basing it on a pre-defined one. 

 1 Open the Dashboard module and click Analysis View. 

 2 Click on the target folder and subfolder: 

➤ Private: Report is only available to current user.

➤ Public: Report is available to all users of the project.

 3 Choose Analysis > New Excel Report. Specify a name for the report.

 4 Click Query Builder. Quality Center opens the Entity View in the right 
pane.

 5 Select an entity in the right pane and expand it to view the parameters. 
For a list of entities, see "Application Component Query Builder Entities" 
on page 174.

 6 Drag a parameter to a location within the Query Builder editor. Modify 
the SQL as required.

 7 Use the Test Query and Run Query button to test and run the query.
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 8 Click OK to save the report. You can open this report and run the query at 
a later time.

For details on how to customize the Excel reports, see the HP Quality Center 
User’s Guide.

How to Generate Graphs

This task describes how to create graphs for your Application Components 
and the changes associated with them. 

This task includes the following steps:

➤ "Open the New Graph dialog box" on page 183

➤ "Configure the graph" on page 184

➤ "Select different projects - optional" on page 184

➤ "View the Graph" on page 184

Open the New Graph dialog box 

Use the Dashboard module to generate pre-defined graphs.

 1 Open the Dashboard module and select the Analysis View tab.

 2 Select Analysis > New Graph (Ctrl+G).

 3 Select an Entity - Application Components or Application Changes.

 4 Select a graph type: Summary Graph, Progress Graph, or Trend Graph.
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 5 Specify a graph name and click OK.

Configure the graph

 1 Click the Configuration tab in the right pane.

 2 Select values for the relevant fields.

For details about the configuration options, see "Application Component 
Graphs" on page 175 or "Application Changes Graphs" on page 178.

Select different projects - optional

To plot graphs using data from other projects, click Select Projects in the 
bottom right pane, and select the relevant project. 

View the Graph 

Click the View tab to view the graph. 

For more information on graphs, see the HP Quality Center User’s Guide.
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Custom Script Generators 

This chapter includes:

Concepts

➤ Creating Custom Script Generator Overview on page 185

Tasks

➤ Implement and Register a Custom Generator on page 186

Reference

➤ Script Generator API Reference on page 189

➤ Test Generation Flow on page 192

Concepts

Creating Custom Script Generator Overview 

The purpose of the custom script generator is to allow programmers to 
extend the capabilities of the Service Test Management Requirement and 
Test Generation Wizard. 

Use this feature in conjunction with the custom type components, to make 
them more readily accessible. For details, see "Component Types Tab" on 
page 147.
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This API enables you to develop an external script generator through COM 
or .NET which can be used by Service Test Management during test 
generation. After you implement the custom generator, Service Test 
Management adds it to the list of script generators in the Requirement and 
Test Generation wizard.

When you run the wizard, Service Test Management invokes the API of the 
custom generator to fill the tests with code, according to the desired logic. 

The API includes initialization of the custom generator for the specified 
aspects and the generation of scripts for tests associated with the 
component.

Tests created by the custom generator use the custom type name. The 
required fields are populated by default values and by user provided values. 
The wizard shows the required fields and their values in the first step.

The Service Test Management installation includes a sample script 
generator. To install this script generator, run the 
ScriptGeneratorExampleSetup.msi file in the in the <Service Test 
Management installation>/ScriptGeneratorExample folder on the server 
machine. This creates a new script generator titled Custom Manual Tester. 
This folder also contains project and source files of a .NET sample.

You can implement the script generator as a COM or .NET object. For both 
COM and .NET implementations, use the IScriptGenerationTaskInfo 
interface to capture generation task data when reporting generation events.

Tasks

Implement and Register a Custom Generator 

This task describes how to implement and register a custom generator. You 
can implement the script generator as a COM or .NET objects.
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Tip: For a use-case scenario related to this task, see "Test Generation Flow" on 
page 192.

This task includes the following steps:

➤ "Prerequisite" on page 187

➤ "Capture the task data - optional" on page 187

➤ "Implement a COM object - optional" on page 187

➤ "Implement a .NET object - optional" on page 188

➤ "Add the Registry key" on page 188

Prerequisite

Make sure to have the Service Test Management client on the development 
machine, so that you may add a reference to SOAClient or StmApi. You can 
install the client either by accessing Service Test Management through your 
browser or by installing the client side installation of Quality Center and 
Service Test Management. For details, see the Installation guide.

Capture the task data - optional

To capture generation task data when reporting generation events, use the 
IScriptGenerationTaskInfo interface for both COM and .NET 
implementations.

Implement a COM object - optional

Link the project to the SOAClient.dll located in the C:\Program 
Files\Common Files\Mercury Interactive\Quality Center folder. Implement 
the following interfaces:

➤ IScriptGenerator. Implements the script generator mechanism.

➤ IScriptGeneratorCallback. Implements COM events.
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Implement a .NET object - optional

Link the project to the StmAPI.dll located in the C:\Program Files\Common 
Files\Mercury Interactive\Quality Center\client folder. Implement the 
INetScriptGenerator interface.

Declare the following as COM source interfaces:

➤ IScriptGeneratorCallback 

➤ The .NET object

Note: You must register the custom generator as a COM object, even if was 
implemented as a .NET object. 

Add the Registry key

In order for Service Test Management to include a new script generator type 
in the Generation wizard, you need to add it to the registry:

Add a registry key with the name of the generator, under 
HKEY_LOCAL_MACHINE\SOFTWARE\Mercury Interactive\Service Test 
Management\ScriptGenerators\<your_generator_name>. 

Set the key with the following values:

Key name Description

COM ID A string value, set to the COM ProgID, used to create the 
COM object. This is the COM object that implements the 
above interfaces and logic.

Test Type A string value, set to the Quality Center test type that the 
custom generator supports. For example, MANUAL or 
DB-TEST.

Name A string value, indicating the name to display in the list 
of test generators in the first step of the Generation 
Wizard.
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Reference

Script Generator API Reference 

The following section provides the API of the StmAPI.dll.

IScriptGenerator Interface
The following is the object definition:

Description A string value, describing the custom generator. This is 
currently not used, but reserved for future 
implementations.

Supported Version A dword value, specifying the version of Service Test 
Management supported by the custom generator. Set this 
value to 10.50.

object,
uuid(B60C546F-EE91-48a2-A352-CFC36E613CB7),
dual,
nonextensible,
helpstring("IScriptGenerator Interface"),
pointer_default(unique)

Key name Description
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This section provides the interface:

IScriptGenerationTaskInfo Interface
The following is the object definition:

interface IScriptGenerator : IDispatch{
[helpstring("Init the Script generator")] 
HRESULT Init();

[helpstring("Set generation parameters")] 
HRESULT SetGenerationData([in] IList *SelectedAspects, [in] 

SAFEARRAY(VARIANT) AdditionalData);
[helpstring("Report how many tests are required for a given component, and a given 

aspect, according to already set aspects and additional data")] 
HRESULT EvaluateTestCount([in] IService *Service, [in] IServiceAspect *Aspect, 

[out] int *TestsCount);
[helpstring("Start generation for a given service")] 

HRESULT StartGenerationForService([in] IService *Service, [in] IList *Tests);
[helpstring("Stop all current generation")] 

HRESULT StopGeneration();
[helpstring("General purpose error reporting")] 

HRESULT GetLastError([out] BSTR *Error);
};

object,
uuid(73C9EFD1-3B4C-4fbb-AF29-2AB59E6ABACB),
dual,
nonextensible,
helpstring("IScriptGenerationTaskInfo Interface"),
pointer_default(unique)
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This section provides the interface:

IScriptGeneratorCallback Interface
The following is the object definition:

This section provides the interface:

Note: The StopGeneration and GetLastError methods are currently not in 
use.

interface IScriptGenerationTaskInfo : IDispatch{

[propget, helpstring("Task status message")] 
HRESULT StatusSucceeded([out] VARIANT_BOOL *Success);

[propget, helpstring("Task error message")] 
HRESULT ErrorMessage([out] BSTR *Error);

[propget, helpstring("The id of the generation aspect this task is handling")] 
HRESULT AspectID([out] int *AspectID);

[propget, helpstring("The id of the generated test this task is handling")] 
HRESULT TestID([out] int *TestID);

[propget, helpstring("The name of the generation aspect this task is handling")] 
HRESULT AspectName([out] BSTR *AspectName);

};

object,
uuid(BEEE5AA8-002E-4221-B99B-6E592F23E17E),
dual,
nonextensible,
helpstring("IScriptGeneratorCallback Interface"),
pointer_default(unique)

interface IScriptGeneratorCallback : IDispatch{

[helpstring("Generation task started")] 
HRESULT TaskStarted();

[helpstring("Generation task ended")] 
HRESULT TaskEnded([in] IScriptGenerationTaskInfo *TaskInfo);

};
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Test Generation Flow 

The following section describes the flow of actions Service Test Management 
performs while creating tests through a custom script generator:

 1 Creates the custom generator through its COM registration (even for .NET 
objects). 

 2 Registers the generation events. If the custom generator is a COM object, it 
registers them through Advise. For a .NET object, it registers the .NET events 
directly.

 3 Calls Init to run all initialization code before the actual generation process.

 4 Calls SetGenerationData with the selected aspects as the first argument and 
null as the second argument. The AdditionalData argument is not used, and 
reserved for the future. The custom generator uses this call to store the 
selected aspects and prepare for generating scripts for these aspects.

 5 Starts the generation process in a new thread, to keep the user interface 
active.

 6 Loops through the selected component or component group. For each 
component, Service Test Management:

 a Loops through the selected aspects and calls EvaluateTestCount for the 
component and each of its aspects. The custom generator implements 
this method to return the number of tests to generate for that 
component and aspect. This is usually one test, but it can also be a 
multiple number of tests.

 b Creates the tests and initializes their fields' values. It posts the tests so 
that the custom generator receives actual, not virtual, tests.

 c Calls StartGenerationForService for the current component and its tests 
for each of the aspects.

 d The custom generator creates the test scripts using the OTA API or any 
other third party API. As these are actual tests, the custom generator can 
read and write to their fields, upload attachments, and so forth.
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 e During script generation, the custom generator should invoke the 
TaskStarted event before generating each test and the TaskEnded event 
after completing the test generation. The status of the script generation 
for that test should be reported in TaskEnded TaskInfo argument 
(implementing the IScriptGenerationTaskInfo interface), indicating the 
following values:

➤ Status of the task 

➤ Error message (if applicable)

➤ Aspect ID 

➤ Script Name

➤ Test ID

 f Service Test Management displays the data and stores the information to 
make it available for other uses, such as linking the test with 
requirements.

 g Service Test Management posts the tests again, committing any changes 
to their fields' values.

 h If requirements were also generated through the wizard, Service Test 
Management links the tests to their respective requirements.
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